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SOFTWARE LICENSE AGREEMENT
This is a legal agreement between you (either an individual or an entity) and Northwest Geophysical Associ-
ates, Inc. (NGA).  By using this software, you agree to become bound by the terms of this agreement. The
term “SOFTWARE” also shall include any upgrades, modified versions or updates of the software licensed to
you by NGA. The SOFTWARE that accompanies this license is the property of NGA and its Licensors and is
protected by copyright law. If you do not agree to the terms of this Agreement, do not use the software.
Promptly return the entire package to NGA or the distributor where you obtained it for a full refund.

1. GRANT OF LICENSE.  NGA and its Licensors, grant to you, the Licensee, the nonexclusive right to use
this SOFTWARE as defined by this agreement. The term of the license is indefinite unless there is a breach of
the license agreement. Upon termination, the purchaser returns all copies of the SOFTWARE and documen-
tation together with a signed affidavit to the effect that all copies have been returned. Licensee is granted
permission to print, as necessary, the electronic User’s Guide for Licensee use only.

2. SCOPE OF LICENSE.  If you acquired a Single-User License, you may install the SOFTWARE on
different computers at your physical address and you must have a mechanism or process in place to assure that
only one copy of the program is in use at any time for each license. If you acquired a “SITE LICENSE” you
are granted the right to use the SOFTWARE simultaneously on the number of computers granted by the SITE
LICENSE at your physical address.

3. OWNERSHIP OF SOFTWARE.  NGA and its Licensors retain the copyright, trademarks, titles, and
ownership of the SOFTWARE and the related written materials regardless of the form or media on which the
original and other copies may exist.  The Licensee may make one (1) copy of the SOFTWARE solely for
backup purposes. You must reproduce and include the copyright notice on the backup copy. You may not
reverse engineer, decompile, or disassemble the SOFTWARE.  This Agreement does not grant you any intel-
lectual property rights in the SOFTWARE.

4. SUPPORT.  Licenses include service contract support and updates for six months from original purchase
date. Support includes phone assistance, prompt correction of reported errors, manual revisions, and periodic
SOFTWARE updates. Support is available after the initial six month period for a fee and includes any product
updates during that support period.

5. TRANSFERS.  You may transfer the SOFTWARE from one computer to another at the Licensee physical
address provided that the SOFTWARE is used in accordance with Section 2, SCOPE OF LICENSE, as
written above. Except within the bounds of this agreement, you may not distribute copies of the SOFTWARE
or accompanying written materials to others. You may not transfer the SOFTWARE to a different physical
address or anyone else without the prior written consent of NGA. In no event may you transfer, assign, rent,
lease, sell or otherwise dispose of the SOFTWARE on a temporary basis.

6. LIMITED WARRANTY.  With respect to the distribution media and physical documentation enclosed
herein, NGA warrants the same to be free of defects in materials and workmanship for a period of 60 days
from the date of purchase. In the event of notification within the warranty period of defects in material or
workmanship, NGA will replace the defective distribution media or documentation. The remedy for breach of
this warranty shall be limited to replacement and shall not encompass any other damages, including but not
limited to loss of profit, special, incidental, consequential, or other similar claims. NGA and its Licensors do
not warrant that the SOFTWARE will meet your requirements or that operation of the SOFTWARE will be
uninterrupted or that the SOFTWARE will be error-free.
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NGA AND ITS LICENSORS SPECIFICALLY DISCLAIM ALL OTHER WARRANTIES, EXPRESSED
OR IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE.  IN NO EVENT SHALL NGA AND ITS LICEN-
SORS BE LIABLE FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGE, INCLUD-
ING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES.

7. GENERAL.  The laws of the State of Oregon will govern this Agreement. This Agreement may only be
modified by a license addendum, which may accompany this license, or by a written document which has
been signed by both you and NGA. Should you have questions concerning this Agreement, or if you desire to
contact NGA for any reason, please write: NGA Client Sales and Service, P.O. Box 1063, Corvallis, OR
97339-1063, USA.
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1.  INTRODUCTION

GM-SYS is a program for calculating the gravity and
magnetic response from a geologic model.  GM-SYS
provides an easy-to-use interface for interactively
creating and manipulating models to fit observed
gravity and/or magnetic data.  Rapid calculation of
the gravity and magnetic response from 2D and 2¾-D
models speed the interpretation process and allows
you to quickly test alternative solutions.

1.1 GM-SYS EDITIONS
Northwest Geophysical Associates offers  several
GM-SYS configurations to match your modeling
needs. The table below shows these configurations
and the features available in each.

Professional License

The Professional Edition is our standard offering to
commercial and academic geophysicists. With ap-
propriate options, model sizes can have up to 16,000
points and 300 blocks.

Engineering License

The economical Engineering Edition is used for less
sophisticated modeling applications.

LAB (Site) License

The LAB Edition is exclusively licensed to academic
institutions.  The LAB Edition is configured for stu-
dents who are learning Potential-Field theory.

1.2 GM-SYS FEATURES
2¾-D Modeling allows blocks to be truncated in the
± Y direction and asymmetrically-positioned about
the line of the profile.

Joint Inversion/Optimization permits inverse mod-
eling of gravity and/or magnetic data to obtain the
optimal fit of the geologic model to your data.

Gravity/Magnetic Gradients allow you to calcu-
late any or all of the six gradient tensor components
of the gravity field and the vertical gradient of the
total magnetic field.

License Blocks Stations
M ag.       Grav. 2.75D Inversion Seismic

Bitmap Gradients Grid
Output

LAB 7 35         35

Engineering
  Basic
  Advanced

10
10

300       300
300       300

Professional
  Basic
  Intermediate
  Advanced

125
125
300

1,000    1,000
1,000    1,000

16,000  16,000
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Seismic Bitmap permits integration of seismic data
or other depth-scaled information (e.g. scanned cross-
sections) into the modeling process.

Grid Output allows you calculate the response of a
model as a Geosoft grid (.grd) file.  You may elect to
calculate the response at a fixed elevation, or at a
constant terrain separation.

Extended Model Size increases maximum allowable
model size to 750 surfaces and 300 blocks.

High Resolution Modeling increases the number of
allowable gravity and magnetic observation and cal-
culation points to 16,000.

Oasis montaj Links allow you to build, modify, &
plot GM-SYS models from within Oasis montaj.
Luanching GM-SYS from within Oasis montaj en-
ables cursor tracking between all open Geosoft maps
and databases and your GM-SYS model.

CVTGMS is a file conversion program that is in-
cluded in every GM-SYS configuration.  CVTGMS
can perform file conversion on the following geo-
logic model files:

• DIG format - Generic 2-D ASCII digitized file,
• XYZ format - Generic 3-D ASCII digitized file,
•  DXF format - AutoCAD® DXF format,
•  IHF format -Paradigm Geophysical, Ltd.,

GeoSec® Import Horizon Format
•  MMD format -Geophysical Micro Computer Ap-

plications, Ltd.,
•  2-Mod® format - Fugro-LCT, Inc. ,
•  GAMMA format - Chevron-Texaco, and
•  SAKI format - USGS.

1.3 SUPPORTED PLATFORMS
GM-SYS is supported on x86-compatible systems
running Microsoft® Windows® NT®, Windows
2000,and Windows XP operating systems.

1.4 TECHNICAL SUPPORT
NGA will provide technical support for any prob-
lems you have with GM-SYS for those licensees with
current service contracts.  If you have a problem or
question, please refer to this manual first.  If the prob-
lem is not covered by this manual or the Help file,
you may call NGA, Monday through Friday between
8:00 AM and 5:00 PM Pacific Coast Time.  You may
also e-mail questions or comments to NGA at any
time.

NGA encourages users who have internet access to
upload problem models or files to our anonymous-
ftp site to facilitate prompt correction of any prob-
lems.  Please notify NGA Technical Support staff by
phone or e-mail (support@nga.com) in the event that
you have uploaded files

Northwest Geophysical Associates, Inc.
Mailing Address:
P.O. Box 1063
Corvallis, Oregon  97339-1063 USA
Phone: (541) 757-7231
FAX: (541) 757-7331

e-mail: support@nga.com
 ftp: nga.com
WWW: http://www.nga.com

Your initial purchase of GM-SYS entitles you to free
support, including any released updates, for a period
of one year.  To extend your support beyond one year
and to receive additional updates, contact NGA.
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2. GETTING STARTED

If you're new to GM-SYS, first install the software
as described in the instructions below.  We recom-
mend that you then use one of the sample models to
practice using the GM-SYS interface and familiar-
ize yourself with the capabilities of the software as
you browse through the following sections.  When
you feel fairly comfortable with the interface, work
through the tutorial included in Section 11.

If you are already familiar with GM-SYS, install the
software as instructed below and then read the Re-
lease Notes document, paying particular attention to
the What’s New... section.

2.1 INSTALLATION
To begin the installation process, run the installation
script <CD_Drive>:\setup.exe.  Following ac-
ceptance of the license, you will be asked to specify
the GM-SYS installation directory.

If Oasis montaj is detected on your system (Oasis
montaj 5.1.x, Oasis montaj 6.x, and/or Oasismontaj
Viewer 6.x are supported), you will be given the op-
tion of installing Oasis montaj Link files that allow
GM-SYS and its utilities to run within and utilize
the Oasis montaj environment.  You may elect to in-
stall the link files in any or all of your Oasis montaj
distributions.

If you install OASIS montaj at a later time, you may
rerun setup.exe and add the OM5 links and/or OM6
links components.

2.2 LICENSE MANAGEMENT
Many copies of GM-SYS are delivered with some
type of license protection.  Generally, GM-SYS is
licensed for a single user.  GM-SYS may be copied

to the hard disk of several computers, but the license
protection must be present for GM-SYS to execute.
If you are operating in an environment where you
feel GM-SYS may be subject to theft or unautho-
rized copying, please contact NGA and we will sup-
ply you with a protected copy at no charge.

2.2.1 Keylock or dongle Protection

GM-SYS may be configured to use a hardware
keylock, commonly called a "dongle".  When this
protection is enabled, a keylock must be present on
the parallel or USB port of the computer for GM-SYS
to execute or continue running.  Keylocks are trans-
parent to other computer operations, so they may be
left on the computer while you are printing or run-
ning other software.  Parallel port keylocks may also
be attached in series with most other keylocks.

New distributions of GM-SYS may shipped with a
Sentinel SuperProTM parallel port or USB keylocks.
If your license requires a keylock, you will be asked
whether to install the drivers during the installation.
If you elect not to install the driver at this time, you
may  install  the driver later by running the  installa-
tion program in \gmsys\spro.

WARNING:  You should not attach the keylock until
after the driver is installed!  USB keylocks, in par-
ticular, may be damaged during the driver installa-
tion procedure.

2.2.2 Geosoft Licensing

Copies of GM-SYS licensed from Geosoft, either
“standalone” or with OASIS montaj, are protected
by the Geosoft "Red Disk" license (5.1.x) or
eLicensing (6.x).  See yourGeosoft documentation
for details.
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2.3 CREATING A NEW MODEL
Select the New Model… option from the File Menu
or click the New Model button on the Menu Tool
Bar to activate the New Model Creation dialog box,
shown on the following page.  The new model cre-
ation process allows you to specify the initial param-
eters of your model, or you may accept the default
settings.  All of these parameters may be changed at
a later time.

2.3.1 Overview of New Model Creation

A starting GM-SYS model consists of two blocks
("air" and "crustal rock"), and optional topography,
and gravity and/or magnetics stations.  All GM-SYS
models extend to ±30,000 kilometers ("infinity") in
the -X and +X directions to eliminate edge-effects.
You may optionally specify up to 6 horizons which
divide the crustal rock into horizontal layers as a start-
ing point for your model.  Within these crustal layers

you will later create the structural and stratigraphic
boundaries (using Split Block, Move Point, Import
Horizon and other actions) which make up your com-
pleted model.

The New Model Creation dialog box is partitioned
into four sections.  The first section contains options
for setting horizontal and depth extents of the model‘s
area of interest in the units of your choice and a ra-
dio button to allow you to specify starting horizons.
The second section allows you to set the profile azi-
muth and relative model strike.  The third section
allows you to specify the locations of topographic
points, gravity stations, and magnetic stations.  The
last section allows you to set the Earth's magnetic
field parameters.

2.3.2 Cross-Section Limits

Setting the X Range defines the initial View of the
model; i.e., the portion of the model you will be ed-
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iting.  The Z Range limits the vertical extents of the
starting "crustal rock" block and the Z-extents of the
initial View.  In GM-SYS models, the Z-axis is posi-
tive down (depth), so positions above sea-level have
negative Z-values. For convenience, some dialogs
allow you to enter Z-values as elevations (positive
up).

Selecting Add Flat Horizons brings up a dialog which
allows you to enter up to six depths for horizons in
your starting model.  These horizons will extend from
“- infinity” to “+ infinity” across your model, divid-
ing the crustal rock into horizontal layers.  For hori-
zons above sea level (but below topography) enter
negative “depths”.

2.3.3 Profile Azimuth/Relative Strike Angle

Setting these options orients your new model in space.
This is necessary only for modeling magnetic re-
sponse, but is good practice, regardless.  The profile
azimuth is relative to geographic North.  The rela-
tive strike angle is relative to the profile azimuth.
See Section 3.5 for a thorough discussion of these
topics.  If you are unsure of the appropriate values,
you may accept the defaults and make changes later.

2.3.4 Topography and Gravity & Magnetics
Stations

You may choose to have no topography, evenly-
spaced topography at a constant elevation, or you
may import topographic data points from a file.  Se-
lecting "none" produces a horizontal surface at el-
evation 0 with no points.  Choosing the second op-
tion activates a Surface Topography dialog box

(shown below), in which you may enter the Refer-
ence elevation (Z is positive up in this case), the X-
coordinate of the first topographic point, the point
spacing, and the total number of topography points.
The "import from file" option allows you to select
and browse an ASCII text file containing the X- and
Z-coordinates of your topographic points in space-
delimited format.  Options to skip lines and/or select
fields in the imported text file allow some flexibility
in file formats.  For instance, you may use the grav-
ity data from an existing model to create topography
(and gravity stations) for a second model by import-
ing the .grv file and skipping the two header lines.

Options for creating gravity and magnetics stations
operate in a similar manner, with a couple of excep-
tions.  Selecting "none" for gravity or magnetics sta-
tions will result in no stations being created.  If you
don't have actual "observed" data, but wish to calcu-
late the response for a hypothetical profile over your
model, you must create "dummy" stations using ei-
ther the "equally spaced…" or "import from file"
options.  (Remember:  Gravity and/or magnetic sta-
tions are required so that GM-SYS may calculate the
response of the model at these locations.)  When im-
porting gravity and magnetics station locations from
ASCII text files, if a third field (column) exists, it
will be imported as observed values.

2.3.5 Choosing the Gravity Anomaly to Model:
Free-Air, Residual, or Bouguer

If you are attempting to fit calculated values to ob-
served values of gravity, you may use free-air, re-
sidual, or Bouguer gravity values for the observed
values.  Note that the model calculations will include
the contributions of the terrain above sea level using
the selected densities.  Therefore, if you use observed
Bouguer anomaly values, you must either change the
density of the "air block" to the Bouguer reduction
density or convert the densities of all blocks above
sea level to density contrasts relative to the Bouguer
reduction density.  Typical densities for various rock
types may be found in Clark (1966), Dobrin and Savit
(1988), or many other references.
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2.3.6 Earth's Magnetic Field

The magnitude and direction of the Earth's magnetic
field in the vicinity of your survey must be entered
correctly for GM-SYS to properly calculate the mag-
netic response of the model.  When modeling Ro-
tated-to-the-Pole or Rotated-to-the-Equator data, you
must enter the modified field direction in GM-SYS.

If you do not field magnitude and direction, the mag-
netic response can not be calculated.  You will be
prompted for this information each time you open
the model until values are entered.

When you have entered all of the information, select
the "Create" button and GM-SYS will generate your
starting model.  Be sure to save the model and any
subsequent changes.

2.4 IMPORTING A MODEL FROM
ANOTHER MODELING
APPLICATION
Additional conversion options may be licensed to
enable CVTGMS to convert flat ASCII files, digi-
tized models, DXF files, and model files from other
common modeling programs to GM-SYS model files.
See Section 8 for more details regarding CVTGMS.

2.5 MENU OVERVIEW
All of the commands necessary for creating and ma-
nipulating GM-SYS models are available in the
menus at the top of the Main Window.  The menus
are described briefly below.  Each menu option or
function is described in detail in Section 5.1.

File Menu

The File Menu controls model creation, saving, and
printing/plotting functions.  The Preferences are also
accessed from this menu.

View Menu

You may store, edit, and recall screen views, or win-
dows, of the current model from the View Menu.  A
view is defined by the current X and Z limits of the
Cross Section, Anomaly, and Plan-View panes of the
Model Window.

Overlay Menu

The Overlay Menu allows you to add and configure
a variety of visual aids to your model, including
bitmaps (if licensed), symbols, and LAS wells and
Well markers.    Global block color fill is also con-
trolled in this menu.  Display of each loaded object
may be toggled and configured independently.  Items
in the Overlay Menu do not affect computation of
the model response.

Display Menu

From the Display Menu you may toggle on and off
the display of all features in the Model Window, with
the exception of surfaces and gradients.  The Dis-
play Menu is arranged so that items affecting each
pane of the Model Window are grouped together.
Single Block Response must be toggled on here in
order to display the response curves.  You may also
toggle between cgs, SI, or µcgs units for displaying
your model parameters.
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Profile Menu

From the Profile Menu, you may set the geomag-
netic field parameters, adjust the DC Shift values,
globally change station elevations, and edit well-
marker data.  Spreadsheet may be accessed to edit
the data profiles or edit block parameters.

Gradients Menu

From the Gradients Menu you may toggle on and off
the display of gravity and magnetic gradients or in-
dividual gradient components.  You may also choose
whether to align the gradient component axes with
the profile direction or compass direction.  If
GM-SYS is not registered to include gradient calcu-
lations, items in this menu may be either absent or
"grayed-out" and inactive.

Action Menu

The Action Menu contains functions for editing the
model.  Only one function may be active at a time.
Each of the items in the Action Menu enables spe-
cific actions when the left mouse button is pressed in
the Model Window.  These items are also available
from the Action Tool Box.  The Undo function is
also accessible from the Action Menu or the Menu
Tool Bar.

Compute Menu

From the Compute Menu you may control recalcu-
lation of the model response.  "Autocalculation" of
the gravity and/or magnetic response to changes in
the model may be toggled on/off.  You may also ac-
tivate a total recalculation of gravity or magnetic re-
sponse, if desired.  The "calculate" or "total recalcu-
late" options should be selected when the "model
changed" flags appear in either of the anomaly panes.

Attempting to save an output grid with the Calc
Geosoft Grid function will fail with an error mes-
sage if the Grid Output option is not licensed.

Window Menu

The Window Menu controls the appearance and or-
ganization of open models within the Main Window.
Open model windows may be tiled or cascaded, and
model icons arranged to minimize desktop space re-
quirements.  A selection list allows you to select the
active open model.

Help Menu

From the Help Menu you may access the on-line help
which comes with GM-SYS.  The About… option
displays registration, version and technical support
information for GM-SYS.
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3. MODELING CONCEPTS

Forward modeling involves creating a hypothetical
geologic model and calculating the geophysical re-
sponse to that earth model.  GM-SYS is a modeling
program which allows intuitive, interactive manipu-
lation of the geologic model and real-time calcula-
tion of the gravity or magnetic response.  The
GM-SYS Inversion option allows you to automati-
cally optimize your model.

3.1 UNIQUENESS
Gravity and magnetic models are not unique; i.e. sev-
eral earth models can produce the same gravity and/
or magnetic response.  Furthermore many solutions
may not be geologically realistic.  It is the task of the
interpreter to evaluate the "geologic reasonableness"
of any model.

3.2 DC SHIFT
A constant or DC shift usually must be subtracted
from the calculated gravity and/or magnetic data to
match the observed data.  For gravity, this is neces-
sary because the calculated value is an absolute grav-
ity calculation for the model extending to 30,000 km
in the ±X directions, and to some arbitrary depth (50
km by default).  Observed data is generally corrected
for the reference geoid, or referenced to some local
datum.  For magnetics, the calculated value is the
deviation from the ambient earth field value, whereas
another datum may have been used for the observed
data.

In GM-SYS, a DC shift can be applied to the calcu-
lated curve to force the calculated curve and the ob-
served curve to match.

GM-SYS allows you to apply a DC Shift in one of
three ways:

1) GM-SYS can automatically calculate the DC
Shift to minimize the RMS error, or

2) you may select a point at which the calculated
and observed curves will be forced to match, or

3) you may enter the DC Shift explicitly.  GM-SYS
defaults to option 1, the automatic shift.

These options are available in the Profile Menu and
the anomaly pane pop-up menus (See Section 5.1.5).

3.3 2-D MODELING
Two-Dimensional (2-D) models assume the earth is
two dimensional; i.e. it changes with depth (the Z
direction) and in the direction of the profile (X di-
rection; perpendicular to strike).  2-D models do not
change in the strike direction (Y direction).  A 2-D
model may be visualized as a number of tabular
prisms with their axes perpendicular to the profile
(see below); blocks and surfaces are presumed to ex-
tend to infinity in the strike direction.
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3.4 2¾-D MODELING
 2¾-D modeling, as implemented in GM-SYS, al-
lows the prisms to be truncated at some distance in
the plus and minus strike directions (± Y).  It also
allows the strike direction to be skewed relative to
the profile azimuth.  Beyond the ends of the prisms
are new prisms of the same cross section, but with
different densities and magnetic properties.  GM-SYS
2¾-D models allow independent specification of the
locations of the two ends of the prisms (blocks).  They
may be asymmetrically-positioned about the line of

the profile or, if desired, both may be on the same
side of the plane of the profile (Y=0) (see figure at
left).

3.5 SKEWED MODELS
GM-SYS with 2¾-D enabled allows the strike di-
rection to be skewed (i.e., not perpendicular) to the
profile.  The angle measured from the profile to the
strike direction is entered as the "relative strike" un-
der the Profile Menu.  For profiles perpendicular to
the strike, the relative strike is 90 degrees.   For 2¾-D
blocks, the Y-axis is in the direction of the model
strike and may be non-orthogonal to the profile.  The
Y=0 reference point for each block is at the left-most
point (minimum X) of the block.  The figure below
illustrates the relationship between the relative model
strike, the profile azimuth, and the Y=0 reference
point (labeled A).
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3.6 INVERSION
Forward modeling involves creating a hypothetical
geologic model and calculating the geophysical re-
sponse to that earth model.  GM-SYS, without the
Inversion/Optimization option, is a forward model-
ing program allowing interactive manipulation of the
earth model and real-time calculation of the gravity
or magnetic response.

Inversion, optimization, or inverse modeling involves
the reverse procedure.  Starting with the observed
geophysical response, an earth model that will pro-
vide the best fit to that data is calculated.  Because
gravity and magnetic calculations are non-linear, the
calculations use an iterative process.  The forward
calculation equations are approximated by linear
equations.  A small change based on the linear equa-
tions is then made to the earth model, the linear ap-
proximations are recalculated for the new model and
the process is repeated.

The Joint Inversion/Optimization option of GM-SYS
allows the user to select the parameters they wish to
free in the optimization process.  It also allows the
user to initiate and monitor the inversion process.

If the Joint Inversion/Optimization option has not
been installed in the copy of GM-SYS currently run-
ning on the computer, the Invert option in the Action
Menu and the Invert button on the Action Tool Box
are "grayed-out" and inactive.

Gravity and magnetic models are not unique; i.e. sev-
eral earth models can produce the same gravity and/
or magnetic response.  Furthermore, many solutions
may not be geologically realistic.  Because of this
non-uniqueness, and because the process is non-lin-
ear, the final result or solution depends on the start-
ing model.  The better the starting model, the better
the result.  As the term optimization implies, Inver-
sion is best used to make small changes to the model
to obtain the final optimal fit to the observed data.
Inversion should not be used to create a hypothetical
earth model from a poorly-defined starting model.

GM-SYS allows the user to free up to 100 param-
eters for inversion.  Parameters may include the X-
and/or Z- position of a point, the susceptibility of a
block, the density of a block, or the DC Shift be-
tween the observed and calculated curves.

Best results will be obtained using optimization if a
limited number of parameters are allowed to be free.
Examples would be inverting on densities of one or
two bodies or inverting on the depth (Z and not X) of
a basin, or thickness (Z and not X) of sediments.

3.7 COMPUTATIONAL BASIS FOR
GM-SYS
The methods used to calculate the gravity and mag-
netic model response are based on the methods of
Talwani et al., 1959, and Talwani and Heirtzler, 1964,
and make use of the algorithms described in Won
and Bevis, 1987.  Two-and-a-half dimensional cal-
culations are based on Rasmussen and Pedersen,
1979. Methods proprietary to NGA have been used
to improve the efficiency and speed of the calcula-
tions and to make them better suited to an interactive
environment.  For validation, the results  from
GM-SYS have been found to be comparable to other
published results; see Campbell, 1983.

The GM-SYS inversion routine utilizes a Marqardt
inversion algorithm (Marqardt, 1963) to linearize and
invert the calculations.  GM-SYS uses an implemen-
tation of that algorithm for gravity and magnetics
developed by the USGS and used in their computer
program, SAKI (Webring, 1985).

GM-SYS uses a two-dimensional, flat-earth model
for the gravity and magnetic calculations; that is, each
structural unit or block extends to plus and minus
infinity in the direction perpendicular to the profile.
The earth is assumed to have topography but no cur-
vature.  The model also extends plus and minus
30,000 kilometers along the profile to eliminate edge-
effects.
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In GM-SYS, stations (points at which gravity or
magnetic values are observed and calculated) should
be outside of the source material; i.e., in an area of
the model with a density, magnetization, and suscep-
tibility equal to zero.

3.8 SINGLE BLOCK RESPONSE
Users may find it instructive to view  the contribu-
tion of an individual block relative to the overall
model response.  The Single Block Response feature
allows you to calculate and display the individual
contributions of up to six blocks.  Each response
curve is color-coded to match the highlighted block.
The response of each block is calculated relative to
the properties of the “Air Block” which surrounds
the model; the magnetic properties of this block are
always zero, while the density is typically zero or
equal to the Bouguer reduction density.

3.9 ROTATED-TO-POLE &
ROTATED-TO-EQUATOR MAGNETIC
DATA
The user may choose to model rotated-to-pole (RTP)
or rotated-to-equator (RTE) magnetic data in
GM-SYS.  When using RTP data, the inclination and
declination of the Earth's field must be set to 90° and
0°, respectively.  For RTE data, use an inclination of
0° and the correct declination for your survey area.
Use the same magnitude for the Earth's field that you
would when modeling Total Field magnetic data.  The
Set Mag. Field option may be accessed either through
the Profile Menu or the Magnetic Anomaly pop-up
menu.

When you build a new model, GM-SYS prompts you
for the Earth’s field information.  Without these  val-
ues, no magnetic response can be calculated.

3.10 CHOICE OF GRAVITY
ANOMALY: FREE-AIR, RESIDUAL,
OR BOUGUER
If you are attempting to fit calculated values to ob-
served values of gravity, you may use free-air, re-

sidual, or Bouguer gravity values for the observed
values.  Note that the model calculations will include
the contributions of the terrain above sea level using
the selected densities.  Therefore, if you use observed
Bouguer anomaly values, you must either change the
density of the "air block" to the Bouguer reduction
density or convert the densities of all blocks above
sea level to density contrasts relative to the Bouguer
reduction density.  Typical densities for various rock
types may be found in Clark (1966), Dobrin and Savit
(1988), or many other references.

3.11 MAGNETIC UNITS
By default, GM-SYS uses the Gaussian (cgs) sys-
tem of units for magnetic terminology and quantities
(susceptibility, magnetization, magnetic induction
and magnetic field intensity).  The user may choose
to display using International  System (Le Système
International d'Unités or SI) or micro-cgs (µcgs) units
by selecting the appropriate option in the Display
Menu.

Geophysical literature is currently in a state of tran-
sition between cgs units and SI units.  Many geo-
physicists continue to use cgs or µcgs units although
SI units do appear in the literature.  Conversion be-
tween cgs and SI units is, at best, confusing.
Five fundamental terms need to be defined for this
discussion.  These terms are (from Blakely, 1995,
Grauch, et al.,1993, and Shive, 1986):

B magnetic induction or magnetic field;
H magnetic field intensity;
J magnetic polarization;
M magnetization;
χχχχχ magnetic susceptibility.

These quantities are defined in different ways in the
two systems by the following equations:

cgs
B = H + 4πM
J = M
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Table 3.1 GM-SYS Units

† Appears as "M" in displayed Block Parameters
‡ Appears as "S" in displayed Block Parameters
§ Also referred to as volume susceptibility

Table 3.2 Magnetic Conversion Factors

†  1 gamma = 10-5 gauss
‡  1 nanotesla = 10-9 tesla
§  Also called emu/cm3.

modified from Blakely (1995)
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SI

B = µ0(H + M)
J = µ0M

where µ0 = 4π x 10-7H/m is the permeability of free
space.
The magnetization M is the vector sum of the in-
duced and remanent components of magnetization:
cgs and SI

M = Mi + Mr

Induced magnetization aligns with the direction of
the Earth's magnetic field H and is proportional to
the magnetic susceptibility χχχχχ so that
cgs and SI

Mi = χχχχχH

The relative importance of remanent magnetization
to induced magnetization is expressed by the
Koenigsberger ratio, Q:

Q=|Mr| / |Mi|

Note that B, H, J and M are vector quantities in the
definitions above.
In GM-SYS, the vector direction for Mr (or Jr) is
input by the user as the remanent inclination (MI)
and declination (MD) in Block Parameters.  The vec-
tor direction for H is input by the user as the inclina-
tion (FI) and declination (FD) of the Earth's mag-
netic field.  The calculated and observed anomalies
in GM-SYS are defined as the magnitude of the
anomalous component of B in the direction of the
Earth's field direction.  This is often referred to as
the total-field anomaly (∆B).

GM-SYS uses the following cgs and SI units (see
Table 3.1):

To convert between SI units and cgs units, use Table
3.2 (modified from Blakely, 1995).  For example,
divide magnetization expressed in A/m by 103 to cal-
culate the magnetization in gauss.

Table 3.3 Example Susceptibilities

modified from Dobrin and Savit (1988)
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Notes:
1. Although susceptibility is dimensionless, it dif-

fers by a factor of 4π between the two systems.
2. The defining equations in this table require

Earth's magnetic field values to be given in oer-
sted (cgs) or A/m (SI).  However, in the geo-
physical literature, the Earth's magnetic field
values are commonly given in gammas (cgs) or
nanotesla (SI).  GM-SYS expects gammas (cgs)
or A/m (SI).

Some traditional geophysical references (e.g., Dobrin
and Savit, 1988) list susceptibilities and magnetiza-
tion in mcgs units (1µcgs = 10-6 cgs).  Simply divide
µcgs units by 106 to use in GM-SYS.  Some examples
of measured susceptibilities using cgs, µcgs and SI
units are provided in a table on the following page.
Note the wide range of susceptibilities for each rock
type.

More extensive measurements of magnetic proper-
ties may be found in Carmichael (1982) and Clark
(1966).  For a more detailed description of magnetic
units, conversions, rock magnetism and theory, see
Shive (1986), Grauch, et al. (1993), and Blakely
(1995).

3.12 GRAVITY UNITS
By default, GM-SYS uses the Gaussian (cgs) sys-
tem of units for gravity terminology (gravitational
acceleration and density).  The user may choose to
display using International  System (Le Système In-
ternational d'Unités or SI) units by selecting the ap-
propriate option in the Display Menu.  Selecting Use
micro-cgs units in the Display Menu will cause

GM-SYS to use cgs units for gravity terminology
and µcgs units for magnetic terminology.  Geophysi-
cal literature is currently in a state of transition be-
tween cgs units and SI units.  Many geophysicists
continue to use cgs units although SI units do appear
in the literature.

By default, gravity anomalies are displayed in mGal
for both cgs and SI, but you may toggle between
mGal or µGal  by right-clicking on the Gravity Axis
and selecting Change Units.

The cgs unit of acceleration is cm/sec2, often referred
to as the Gal (short for "Galileo"), where 1 Gal = 1
cm/sec2.  The geophysical literature commonly re-
ports gravitational attraction in units of mGal (1 mGal
= 10-3 Gal).  The SI unit of acceleration is m/sec2.
The cgs unit of density is gm/cm3 and the SI unit of
density is kg/m3.  GM-SYS expects gravity values to
be in mGal and densities to be in gm/cm3 or kg/m3.
To convert between SI units to cgs units, use the con-
version table below.  For example, divide densities
reported in kg/m3 by 103 to calculate the densities in
gm/cm3.  The density for each block in a GM-SYS
model appears as "D" when the block parameters are
displayed.

Some examples of measured rock densities using cgs
and SI units are provided in Table 3.5 shown below.

3.13 GRAVITY & MAGNETIC
GRADIENTS
The GM-SYS Gravity/Magnetic Gradient option
adds the capability to calculate any or all of six gra-
dient tensor components of the gravity field and the

Table 3.4 Gravity Conversion Factors
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vertical gradient of the total magnetic field.  Most of
the gradient features may be accessed in the Gradi-
ents Menu.  The Enable Grav. Gradients and Enable
Magn. Gradient options in the Gradients Menu are
"grayed-out" and inactive if GM-SYS is not regis-
tered to include these options.

Gradient features include:
• Autocalculation of displayed gradient compo-

nents;
• Calculation and display of the individual com-

ponents or all magnetic and/or gravity gradient
components may be toggled on/off;

• Alignment of the gradient component axes may
be toggled between the profile direction or com-
pass direction;

• Plotting and anomaly scaling are controlled with
the standard GM-SYS functions.

Limitations:
1) Standard gravity (Gz) or magnetics (Bt) values

must exist at each gradient station.  If standard
values do not exist when GM-SYS loads a model
with gradient values, GM-SYS will create
"dummy" Gz and/or Bt values which are set to
zero.  The user can toggle (on/off) the display of
any observed or calculated gradient component
using options in the Gradients Menu.

Note:  X- and Z-coordinates in the gravity (.grv) and
gravity gradient (.gdo) files must be the same.  This
is also true of magnetics (.mag) and magnetic gradi-
ent (.mdo) files.  If the number of observed gradient
stations is different than the number of standard (grav-
ity or magnetics) stations, the smaller file must be
"padded" with dummy stations to match the larger
file.  Failure to do this may result in corrupt models.
Using the Edit Anomaly function, found in the Pro-
file Menu or Anomaly Pane pop-up menus, to add or
change stations will change both files, thereby avoid-
ing this problem.

Table 3.5 Rock Densities

 modified from Dobrin and Savit (1988)
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2) Both the standard gravity (Gz) curve and grav-

ity gradient curves are plotted in the gravity
anomaly window.  Similarly, the total field and
magnetic gradient curves are plotted in the mag-
netic anomaly window.  In each window, the
gradient components are color-coded with a leg-
end displayed in the upper-left corner of the
anomaly window.  A question mark (?) appears
next to the legend items if the calculated curve
has not been updated to reflect changes in the
geologic model; i.e., "?" serves as a "model
changed" flag.  The legend entry for a compo-
nent is only visible when display of the compo-
nent is enabled.

3.13.1 Gradient Axis

The "Profile/Compass" Axis toggle in the Gradients
Menu allows the user to change the alignment of the
X-axis for gradient calculations.  The X-axis for gra-
dient calculation defaults to being coincident with
the profile azimuth (PROFILE).  The COMPASS op-
tion forces the X-Direction in the gradient calcula-
tions to be due East (90°).  The Profile Azimuth must
be set correctly, relative to True North, for this op-
tion to function properly.

3.13.2 Magnetic Gradient Display and Units.

The total magnetic field (Bt) and the vertical gradi-
ent (Btz) are both displayed in the magnetic anomaly
window.  Display of the calculated and observed gra-
dient data may be toggled on and off in the Gradi-
ents Menu.  GM-SYS stores magnetic gradient val-
ues internally in units of gammas/meter, although
units may be displayed and edited in units of gam-
mas/meter, gammas/kilometer, nT/meter, or nT/ki-
lometer.  The units used may be changed by activat-
ing the Magnetic Anomaly axis pop-up menu (see
Section 5.3.8.3) and selecting the appropriate units
from the secondary pop-up menu.

3.13.3 Gravity Gradients Display and Units

"Normal gravity" (Gz) and six gradient tensor
components are displayed in the gravity anomaly
window.

• vertical gradient of the vertical component of
gravity (zz);

• gradient in the X direction of the X component
of gravity (xx);

• gradient in the Y direction of the Y component
of gravity (yy);

• gradient in the X direction of the vertical
component of gravity (zx);

• gradient in the Y direction of the vertical com-
ponent of gravity (zy).

• gradient in the X direction of the Y component
of gravity (xy);

The individual gradient components can be toggled
on and off in the Gradients Menu.  Gradient values
are input and displayed in Eotvos Units.

1 Eotvos Unit

= 10-9 gal/cm
= 10-6 mGal/cm
= 10-4 mGal/m
= 10-1 mGal/km

3.14 GRID OUTPUT
The Grid Output Option allows you to calculate the
response of your model over an area and generate a
Geosoft grid (.grd) file as output.  If the model in-
cludes a coordinate transformation in the ECS file,
the output grid will use the original ground units and
will be correctly rotated.

You may elect to calculate the gravity or magnetic
grid response, or one of the gradient components if
the Gradients Option is licensed.  Calculate the re-
sponse at a specified  constant terrain separation or
constant elevation.  Enter  minimum and maximum
X and Y limits and the grid cell size, or accept the
default limits, which are determined from the Plan
View extents.
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3.15 SYMBOL DISPLAY
Import one or more ASCII files with X, Z coordi-
nates, optionally including symbol index, dip and sus-
ceptibility fields, and display symbols over the Cross
Section pane.  Each symbol file may be configured
independently  to associate symbol indices with sym-
bol type, color, line weight, and size.  Each symbol
file may be toggled on/off independently.  Entries in
a symbol file that enclude dip and susceptibility fields
will plot with ‘dip-tails’ scaled by susceptibility.

Use Symbol Plotting to display dip measurements,
depth-solutions from NGA’s Depth-to-Basement
GXs, shotpoint locations, tie-line crossings, inter-
preted seismic horizons, and more.  GM-SYS comes
with a set of default symbols in gmwin.sdf, the sym-
bol definition file.  Use the predefined symbols, or
add your own.  Symbols do not affect GM-SYS cal-
culations in any way.

3.16 WELL DISPLAY
GM-SYS incorporates two types of wells, the stan-
dard GM-SYS well markers and LAS well files (v.
1.2 and 2.0).  Like symbols and bitmaps, wells pro-
vide visual aids to modeling and do not affect com-
putation of the model response.   You may assign a
predefined well symbols, or add your own symbols.
LAS wells may display up to two log curves with
user-configured scale, color and line weight.  Use
well markers to mark depth(s) to known horizons.

3.17 BITMAP DISPLAY
The Seismic Bitmap Option enables GM-SYS to dis-
play bitmaps in the background of the cross section
pane for use as a modeling aid.  Bitmaps may be seis-
mic depth sections, scanned cross sections, depth-
to-basement picks; any image that may be registered
in GM-SYS model space (i.e. XZ coordinates, where
Z is depth).  Although not all formats have been
tested, the ImageMagick convert program incorpo-
rated into the GM-SYS distribution should read the
following image formats without additional “helper”
applications:

BMP Microsoft Windows bitmap image
BMP24 Microsoft Windows 24-bit bitmap image
CMYK Raw cyan, magenta, yellow, and black bytes
DCX ZSoft IBM PC multi-page Paintbrush
DIB Microsoft Windows bitmap image
FAX Group 3 FAX
FITS Flexible Image Transport System
G3 Group 3 FAX
GIF CompuServe graphics interchange format
GIF87 CompuServe graphics interchange format

(version 87a)
GRAY Raw gray bytes
ICB Truevision Targa image
ICO Microsoft icon
JBG Joint Bi-level Image experts Group interchange
JBIG Joint Bi-level Image experts Group interchange
JPG Joint Photographic Experts Group JFIF
JPEG Joint Photographic Experts Group JFIF
JPEG24 Joint Photographic Experts Group JFIF
MIFF Magick image format
MONO Bi-level bitmap in least-significant-byte

first order
P7 Xv thumbnail format
PBM Portable bitmap format (black and white)
PCD Photo CD
PCDS Photo CD
PCL Page Control Language
PCT Apple Macintosh QuickDraw/PICT
PCX ZSoft IBM PC Paintbrush
PIC Apple Macintosh QuickDraw/PICT
PICT Apple Macintosh QuickDraw/PICT
PICT24 24-bit Apple Macintosh QuickDraw/PICT
PGM Portable graymap format (gray scale)
PMX Windows system pixmap (color)
PNG Portable Network Graphics
PNM Portable anymap
PPM Portable pixmap format (color)
PSD Adobe Photoshop bitmap
PTIF Pyramid encoded TIFF
PWP Seattle Film Works
RAS SUN Rasterfile
RGB Raw red, green, and blue bytes
RGBA Raw red, green, blue, and matte bytes
RLA Alias/Wavefront image
RLE Utah Run length encoded image
SFW Seattle Film Works
SGI Irix RGB image
SUN SUN Rasterfile
TGA Truevision Targa image
TIF Tagged Image File Format
TIFF Tagged Image File Format
TIFF24 24-bit Tagged Image File Format
TTF TrueType font
VDA Truevision Targa image
VST Truevision Targa image
X X Image
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XBM X Windows system bitmap (black and white)
XPM X Windows system pixmap (color)
XV Khoros Visualization image
XWD X Windows system window dump (color)
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4. MODEL ELEMENTS

A GM-SYS model has
four main components;
the structural (geo-
logic) model, addi-
tional external data (i.e.
wells, symbols, back-
drops, and LAS well
curves), gravity sta-
tions and  magnetic sta-
tions.  These features
are illustrated in the
simple model at left.
You may change the default symbol and line colors,
sizes, and weights, and fonts in the Preferences dia-
log accessed from the File Menu.

Conceptually, the model is a 2-D or 2¾-D cross sec-
tion extending to infinity  to the left (-X) and the
right (+X).  The Z-axis of the cross section displays
depth (i.e. Z is positive down).  Areas of constant
density and magnetic properties are delineated by
closed polygons separated by surfaces defined by two
or more points.  In 2-D models, these polygons, or
"blocks" extend to infinity in the third dimension (±Y)
into and out of the screen or page.  In 2¾-D models,
these blocks may be truncated at a given distance
from the plane of the profile.

4.1 SURFACES
To GM-SYS, the
model is actually
composed of lines
that define the sur-
faces between areas
of differing density or
magnetic properties.  You are able to change the sur-
faces by moving, deleting, and adding points that
define these boundaries.  The top of a model is a
surface which defines the topography of the cross
section.  The default colors are green for 2-D sur-
faces and dark green for 2¾-D surfaces.

Horizons are one or more contiguous surfaces con-
nected end-to-end (no branching).

4.2 POINTS
A surface is defined by a series of two or more points
or vertices.  Straight line
segments connecting
these points make up the
surfaces.

4.3 BLOCKS
A polygon, or a block, is
an area of constant den-
sity and magnetic prop-
erties and strike (Y) extent.  The parameters of a block
are the name, the density, the susceptibility (which
combined with the Earth's magnetic field gives the
induced component of the magnetic anomaly caused
by a block),  the magnitude, declination and inclina-
tion of the remanent magnetization, and velocity.
Blocks also may be given a fill pattern with fore-
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ground and/or back-
ground color for display
and plotting purposes.

If the block is 2-D, these
properties extend to “in-
finity” in the +Y and -Y
directions.  If the block
is 2¾-D, the “main”
block has a +Y and/or -Y limit and the “block” ex-
tending from this limit to infinity may be assigned
different properties from the “main” block.  You may
elect to assign separate fill pattern and/or color to
the “+Y-” and “-Y-blocks”, which will only be dis-
played in the Plan View.

4.3.1 Block Labels

Each block is assigned a name, which may be
changed with the Examine option or within the Block
Parameter spreadsheet.
When the Block Labels
option in the Display
Menu is toggled on, all
block names are dis-
played.  You may toggle
the display of individual
block labels off in the
Examine Block dialog.  Note:  the default position
for a block name is the center of the block.  A label
for a newly-created block (e.g. using Split Block)
may default to a position outside of the current view.

Block labels may be moved using the Move Label
command, found in the Action Menu or the Action
Tool Box (Section 5.1.7).  To move the label for a
newly-created block on-screen, activate the Move
Label command and select "Snap Mode".  Click the
mouse within the new block to move the label to that
point.

4.3.2 Block Data

Each block has a density, susceptibility, remanent
magnetization, and velocity assigned to it.  If the
block is 2-D, these properties extend to “infinity” in
the +Y and -Y directions.  If the block is 2¾-D, it has
a +Y and/or -Y limit and the “block” extending from
this limit to “infinity” may be assigned other proper-
ties.  Information for the -Y and +Y- portions of a
2¾-D block are not displayed, but may be viewed
and changed using Examine Block or within the
Block Parameter spreadsheet.  Surfaces surrounding
blocks with 2¾-D limits are displayed with a differ-
ent color in the cross section and plan view (default
is olive).  You may change the default color or line
style in the Preferences.

If either or both of the Grav. Info or Magn. Info op-
tions in the Display Menu are checked, the informa-
tion for the “main” block is displayed beneath the
block label for each block.  Magnetic remanence pa-
rameters are only displayed if the remanent magne-
tization is non-zero.  By default, density, susceptibil-
ity, and remanence values are displayed to three sig-
nificant figures, but this may be changed in the Pref-
erences.

4.4 BACKDROP IMAGES
Backdrop images are used as a visual aid to model
construction, but do not affect the computations per-
formed by GM-SYS.  GM-SYS will import a wide
variety of image formats with the Seismic Bitmap
option.  If an image is too large to load, the user may
elect to have GM-SYS scale the image to a more
manageable size.

By default, the image will be scaled to fill the cur-
rent cross-section view.  If you know the approxi-
mate coordinates of the image corners, you may
specify these values when loading the image.  Once
the image is loaded, use the Register Backdrop func-
tion to precisely register the image.
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The Register Backdrop function allows you to pre-
cisely scale the loaded image by assigning model
coordinates (X,Z) to two pixel lo-
cations in the image.

4.5 SYMBOLS
Symbols are another  visual aid that
does not affect the computations.
Use symbols to show the locations
of depth-to-basement picks, strike
& dip measurements, seismic ho-
rizons, or any other reference lo-
cation that might aid in your model
development or presentation.

Symbol files are space-delimited
ASCII files that contain X, Z, a
symbol flag, and optionally dip and
susceptibility values for each symbol location. Mul-
tiple symbol files may be displayed in a model and
each may be configured independently.

The available symbols are defined in gmwin.sdf, the
symbol definition file.  You may add symbol defini-
tions by editing this file with a text editor.

4.6 WELL MARKERS AND LAS
WELL FILES
Wells are used as a type of annotation, but are not
used in the computations performed by GM-SYS.
GM-SYS allows two types of wells, the standard  well
markers and LAS well files (v. 1.2 and 2.0).

By displaying a well marker, you can show depths
of various stratigraphic horizons or other geological
markers.  This data can come from well logs, core
samples, magnetotellurics, resistivity studies, geo-
logic maps, or any other source you may have.  It is
useful to have these annotations on the screen to keep
track of all of the geological and geophysical con-
straints on the model.

The locations of well horizons are stored as depth
beneath the ground surface (see Section 7.8) and
may be edited from the Profile Menu (Section
5.1.3).

Each LAS Well file may be independently config-
ured to show up to two log curves.  Specify the
well location, symbol, and up to two log curves for
display.  Configure scale, color, and line weight for
each curve.

4.7 GRAVITY AND MAGNETIC
STATIONS
The observed gravity and magnetics profiles are com-
posed of stations.  These stations are the locations
where gravity and/or magnetic measurements have
been made and where the model response will be
calculated.  Gravity stations generally lie on the to-
pography of the model if they are land-based gravity
readings.  Magnetic stations may be on land or at
some altitude, in the case of an aeromagnetic survey.
When GM-SYS calculates the gravity or magnetic
response of a model, it will calculate and plot the
total response of the model at each station.  The ob-
served response at each station over the cross sec-
tion will also be plotted.  This will allow you to model
a cross section to match existing data.

Actual observed data are not necessary for the use of
GM-SYS, but would normally be used when fitting
a cross section to observed data.  If observed data
are  unavailable, dummy station locations must be
entered as calculation points.
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5. GM-SYS INTERFACE

The GM-SYS interface consists of a menu system,
Menu Tool Bar, the Action Tool-Box, the Model
Space, and the Status Bar.  The Model Space may
contain one or more models in separate Model Win-
dows.  GM-SYS is most commonly used as a stand-
alone application, but may be run in linked mode from
within OASIS montaj.

5.1 MENUS
When GM-SYS is started without specifying an ini-
tial model, only three menus with limited options are
available:  the File Menu, Window Menu and the
Help Menu.  The menu system expands to include
additional options when a model is loaded.  Many of
the menu options may also be found in the context-
sensitive pop-up menus described in Section 5.3.8.
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5.1.1 File Menu

The File Menu controls file access, printing and plot-
ting functions.  The New Model…, Open Model…
and Save Model options are also accessible from the
Menu Tool Bar.

New Model and Open Model

The New Model… option activates the New Model
Creation dialog (discussed in Section 2.3), which
guides you through the creation of a starting model.
The Open Model… option allows you to open any
GM-SYS model (default extension .sur).

Save Model and Save as

The Save Model and Save as… options overwrite
the previous version of the model or allow you to
choose a new or different model name, respectively.
For the Save as… option, if a model name is already
in use, GM-SYS prompts you with a message asking
whether you wish to overwrite the existing model.
Models are saved in a group of eight to ten files with
the same name and various extensions (See Section
7).  Hence, it is not recommended that you save mod-
els with an extension other than .sur.

Close

The Close option closes the active model, prompting
you to save any changes that have occurred since the
last Save Model command.  Models may also be

closed using the controls embedded in the window-
dressing of the Model Window.

Preferences

The Preferences... option allows you to personalize
your GM-SYS environment. Preferences can be set
for file locations, the model window, and miscella-
neous items.

In the Files dialog you may select default locations
for your model files, backdrop images, and backup
files generated by the AutoSave feature. With
AutoSave enabled, GM-SYS will save all open model
files at the user-specified interval. In the event of a
system failure or power outage, these files may be
recovered during the next GM-SYS session. The
backup files are deleted when GM-SYS exits nor-
mally.

The Model Windows preference selection includes
the following three dialog menus: Fonts, Anomalies,
and Cross Section.

The Fonts dialog allows you to specify fonts used
for each part of the GM-SYS display.

The Anomalies dialog allows you to set the color,
line style, and weight of each data component in the
anomaly display.  You may also specify whether each
component’s observed data and/or calculated curve
is displayed by default when GM-SYS opens.
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The Cross Section dialog allows you to configure
the color, line style, and weight of the line elements
that comprise the Cross Section display.  You may
also set the number of decimal places to use when
displaying density, susceptibility, or remanent mag-
netization values; these values apply to the Anomaly
spreadsheet, as well.

In the Miscellaneous dialog, you may set the maxi-
mum number of “Undos” and “Previous Views”
saved for each model during a modeling session.  You
may select the default units GM-SYS will use, which
may be overridden on a model-by-model basis.

Beginning with GM-SYS version 4.6, extensions and
changes have been introduced to the .BLK, .SUR,
.ECS, and .GMS file formats.  By default, GM-SYS
uses the new formats when saving a model.  If you
wish to remain compatible with earlier versions of
GM-SYS, you may uncheck this box.  Your models
will not retain block color/pattern information and
will not load bitmap files or symbol files.  Some large
models may fail to load with a “Too many Surfaces”
error message.

Print

The Print… option generates a precisely-scaled plot
of your model for printing or importing into graph-
ics applications.  The Print dialog, discussed in Sec-
tion 6, allows you to set the vertical scale of each
pane and the model horizontal scale, vertical exag-
geration, and model and axis headings.  You may
specify font sizes and font styles.  GM-SYS con-
structs an outline preview of the model layout prior
to printing directly to the installed printer or to a file
for printing later.

Exit

The Exit option will close all open model windows
and terminate GM-SYS.  You will be prompted to
save changes to each open model before it is closed.

You may also exit GM-SYS by using the controls
embedded in the Main Window  window-dressing.

Previously Opened Model List

GM-SYS maintains a list of previously-opened model
files at the bottom of the File Menu.  You may open
any of the listed models by selecting the model name
from the list.  The number of saved file names may
be configured in the Preferences.

5.1.2 View Menu

To GM-SYS, a View is a stored
set of coordinates specifying the
boundaries of the Model,
Anomaly, and Plan View panes
and the depth of the Plan View.
Views are useful when you wish
to repeatedly edit or plot the same
portion of the model.  Using the
functions built into the View
Menu you may save, edit, replace, and delete views,
change to a previously saved view, and change the
order of saved views.

Previous View

The Previous View option allows you step back
through a stack of saved or unsaved views generated
during the current editing session.  Separate view
stacks are constructed for each model opened during
an editing session.  A view is placed on the stack
whenever the zoom functions are used or the range
of any pane in the Model Window is changed.  The
number of views remaining in the stack is displayed
as part of the Previous View option.  By default,
GM-SYS will hold up to 20 views in the stack. The
depth of the stack can be changed in
File|Preferences...|Miscellaneous.  The Previous View
stack for a model is cleared when you close the model
or exit GM-SYS.
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Mark Current View

When the range of the display is changed by utiliz-
ing a scroll bar, GM-SYS does not automatically save
the view on the Previous View stack.  Selecting Mark
Current View will explicitly place the current view
on the stack.

Add Current View

This option allows you to save the current view at
the bottom of the View List, without having to specify
a name.  The view name will default to "New View
#?" where "?" is the position of the view in the list.
You may change the name or any other parameters
of the view using the Edit Views option.

Edit Views

The Edit Views option activates the View List dia-
log.  The View List dialog allows you add, delete, or
change views in the list that appears at the bottom of
the View Menu.

The Up and Dn buttons allow you to reorder your
view list; e.g. you could move the "Salt Dome" view
to the top (default) position.  When an existing view
is highlighted, the Edit button activates the View dia-
log (following page).  This dialog allows you to
change the name and/or the limits of each pane in

the Model Window for that view.  Use the Repl. W/
CView button to replace the highlighted view with
the current screen configuration.

To add a new view, first arrange your display by set-
ting the limits for each pane or by using the scroll
bars.  Then select Edit Views from the View Menu
and choose the Add Current View button.  The View
dialog will display the "New View" with the param-
eters set to the current screen configuration.  Adjust
the values if necessary, give the view a new name
and click "OK."  The new view will be added to the
numbered list.  You may then reorder the views if
you wish.

View List

The first view in the list, named "Start up" by de-
fault, is the initial view displayed when you open the
model.  The "Infinity" view, listed second by default,
shows you the entire model, extending from -30,000
km to +30,000 km along the profile axis.
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5.1.3 Overlay Menu

The Overlay Menu controls
model elements which pro-
vide a visual guide to model
building or otherwise en-
hance the appearance of your
model, but do not affect cal-
culations.

Backdrop

This Intermediate function allows you to place a reg-
istered bitmap image in the background of the cross-
section pane of the model.  The image may be a depth-
scaled seismic section, a geologic cross section
scanned from a publication, a hand sketch, or any
other image that aids in development of your model.

Enable Backdrop

The Enable Backdrop selection toggles on/off the dis-
play of the backdrop image.  This selection must be
set on to display a backdrop image.  You may also
set this toggle in the Backdrop Image Setup dialog
described below.

Load Backdrop

Selecting Load Backdrop will bring up the "Back-
drop Image Setup" dialog, as shown below.  If you
choose a file type other than BMP, GM-SYS uses
ImageMagick to import the image.  A thumbnail of
the image will be displayed after it has been loaded.

Initially, the image will be scaled to approximately
fill the current View.  To adjust the position of the
image in the cross-section pane, enter the User Co-
ordinates to match the outside edges of the image.
Make sure the Enable Backdrop box is checked be-
fore you click “OK.”

Backdrop Registration

You may fine-tune the image registration by assign-
ing model coordinates to two locations in the image,
using the procedure outlined below.  Using locations
near opposite corners of the image works best.

1) Zoom to the first registration point, if necessary.
Right-click in the Cross Section pane to display a
pop-up menu with the Register Image option. Se-
lect the 'Select 1st Reg. Point' item from the pop-
up submenu. The '1st Reg. Point' window will ap-
pear, as shown below.

2) Click on the new registration point on the image.
Its current model coordinates will be displayed in
the dialog. Enter the new coordinates and click 'OK'.

3) Zoom to the 2nd registration point, choose '2nd
reg. point' from the pop-up menu, and repeat the
process.

4) Select 'Apply registration to image' from the Reg-
ister Image pop-up menu to apply the new regis-
tration information.
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Symbols

Point data, such as depth-to-basement picks, seismic
horizon picks, and shot-point or tie-line locations,
may be loaded and displayed as symbols over your
model.  Files may contain Profile (X,Z) or Real-World
(X,Y,Z) coordinates; GM-SYS assumes that the co-
ordinate system and projection of the file match that
of the model.

Load and configure each symbol file independently.
Select from a list of pre-defined symbols, or add your
own symbols, and customize color, size, and line
weight.  Depth-to-basement picks may be plotted with
dip-tails whose length is proportional to the appar-
ent susceptibility.

Enable Symbols

The Enable Symbols selection toggles the display of
all loaded symbol files.  Regardless of how may sym-
bol files are loaded and toggled on (see below), this
option must be toggled on to display any symbols.

Load/Config Symbols

The Load/Config Symbols option brings up the Sym-
bol Manager dialog.  Here you may load, delete, or
reload one or many ASCII files containing (X,Z) or
(X,Y,Z) locations to be displayed as symbols over
your model.  You may elect to show/hide each loaded
symbol file independently and each loaded file may
be configured independently.

A symbol file may contain several different types of
information (e.g. depth to basement picks, shot points,
etc.).  Each line of the symbol file should contain
coordinates for the symbol, a symbol flag, and may
optionally include dip, and susceptibility fields.  The
symbol flag should be a positive integer that is the
same for all points containing the same type of infor-
mation.  Dips should be in degrees.  Susceptibility
units may be either cgs or SI; the length of the dip-
tails will be scaled logarithmically with values of 10-7

scaled to the effective radius of the symbol.

The symbol configuration dialog allows you to asso-
ciate the symbol flag field in your symbol files with
predefined symbols.  If any symbols in a file contain
only X,Z fields, all symbols in that file will be as-
signed the flag value #00.  Each flag value may be
associated with a specific symbol type, size, color,
and line weight.  Symbol files that include dip and
susceptibility information will plot with ‘dip tails’
scaled to the susceptibility.

Edit Wells

Well markers show the locations of borings and for-
mation tops in the Cross Section and Plan View panes.
Wells are located in model coordinates;  i.e. X-Dis-
tance along the profile and Z-elevation of the ground
surface (Z is positive down).  Well horizons are in-
put as depth below ground surface and should al-
ways be positive.  Units for X, Z, and depth to hori-
zons may be independently selected using the pop-
up menus in the Edit Well dialog box.

Enable Wells

This option toggles the display of all Well markers.

Add/Config Wells

You may add, delete, or modify well markers that
appear in the Cross Section and Plan View panes.
Select one of the existing wells to edit, or click the
New button and create a new well.
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LAS Wells

LAS well files (v. 1.2 and 2.0) may be loaded and
one or two curves displayed in your model.  You may
configure line color, weight, style, and scale for each
selected curve.  Well symbols may be selected from
a list of pre-defined symbols, or you may add your
own well symbols.

Enable LAS Wells

The Enable LAS Wells selection toggles the display
of all loaded LAS well files.  Regardless of how may
files are loaded and toggled on (see below), this op-
tion must be toggled on to display any LAS wells.

Load LAS Wells

The Load LAS Wells option activates the LAS Well
configuration dialog.  Here you may load, reload,
and delete LAS well files.  You may elect to show/
hide each loaded LAS well file independently and
each loaded file may be configured independently.

LAS well files may contain one or more log curves.
Once you have specified X, Y, and elevation coordi-
nates for a loaded  well, you may configure up to
two log curves for display, specifying line color, line
weight, and scale for each.  Scaling of curves fits a
specified range of values (e.g. 0 - 3.0 g/cc) into a
specified range of distance from the well location
(e.g. 2 - 8 km).

Block Fill

GM-SYS allows you to specify a block-fill pattern,
a pattern color (the foreground color), and a back-
ground color independently for each block.  Using
this menu, you may elect to display no fill, only the
foreground pattern (fill is “transparent”), or both
foreaground and background colors on a global ba-
sis (all blocks).  You may elect to scale the block
foreground colors by mapping a color table to ranges
of block density, susceptibility, or remanent magne-
tism.  Use the Examine Block command tool to con-
trol block transparency on an individual basis.

Enable Block Fill

This selection toggles on/off the display of block fill
in the Cross Section and Plan View panes.  This toggle
can also be accessed in the Display menu and the
Cross Section pop-up menu.  If Enable Block Fill is
not selected, the three following items do not appear
in the Image menu.

Block Foreground Color

The Block Foreground
Color option displays a pop-
up menu that allows the user
to select one of four choices for selecting the fore-
ground color.  The first selection, "Color Blocks as
Normal" selects the block-fill color and pattern as
set via the Examine Block function or via the Block
Parameter spreadsheet.  The other three selections
utilize the color schemes defined via the Color Tool
option described below.  Note that the Density, Sus-
ceptibility, and Magnetization color schemes only af-
fect the foreground colors.  The background colors
are set via the Examine Block function or the Block
spreadsheet and modified as described below.

Block Background Color

The Block Background
Color option displays a
pop-up menu that allows the user to modify the way
background colors are displayed.  “Fill Blocks as Nor-
mal” uses the background color and transparency as
specified by the user for each block. “Force Blocks
Transparent” overrides the user’s transparency set-
tings and makes all blocks transparent.  “Force Blocks
Solid” fills all blocks with the current foreground
color.

Color Tool

The Color Tool selec-
tion displays a dialog
that allows the user to
assign color tables to
ranges of block prop-
erties (density, suscep-
tibility, magnetization,
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and velocity.  Each block property may use a differ-
ent color table.  Users can import ASCII color tables
in the standard Geosoft RGB or CMYK formats.  Ex-
ported color tables are Geosoft RGB color tables.

5.1.4 Display Menu

The Display Menu is a selection
list that allows you to toggle on/
off all of the model elements that
appear in the Cross Section,
Anomaly, and Plan View panes;
with the exception of the model
surfaces.  The Action Tool Box
and Single Block Response curves
may be toggled on/off from this
menu.  Select either cgs, micro-
cgs, or SI units for block param-
eter and anomaly display from this
menu.

The Display Menu is organized
into sections the Gravity Anomaly,
Magnetic Anomaly, and Cross Section panes.   GM-
SYS displays the same model elements in the Plan
View pane as in the Cross Section pane.  Options
which affect the display of magnetic and gravity
curves may be accessed using the Magnetic and Grav-
ity Anomaly pop-up menus as well.  All other op-
tions may be accessed using the Cross Section pop-
up menu.

Display Menu options affect all open models.  Dis-
play toggles affect all Model Window panes and con-
trol the appearance of model elements on plot out-
put.

5.1.5 Profile Menu

Parameters which affect
calculation of the gravity
and/or magnetic response
of the entire model profile
may be found under the
Profile Menu.  GM-SYS re-
quires that the magnetic
field parameters, the profile
azimuth, and the relative
strike angle be set in order
to accurately calculate the model's magnetic response.
The relative strike angle must be set to properly cal-
culate the gravity response of the model.

Set Mag. Field

Use the Set Mag Field option to input the Earth's
magnetic field intensity, inclination, and declination
at the location of your survey and model.

If you do not have NGRF, this information may be
obtained from a variety of published sources.  Maps
showing magnetic field data may be found in many
geophysical text books (e.g., Merrill and McElhinny,
1983, Fig. 2.2, and Dobrin and Savit, 1988, Fig. 15-
7 and 15-8), or from one of the numerous map series
available from the USGS (e.g., Fabino, 1983, a,b,c).
If you do not have access to these more accurate
sources, the field may be approximated by the Earth's
dipole field.
For that approximation:

Dipole field intensity:
H = 31,200 * (1+ 3sin2 (lat))½  (gammas)

Dipole field inclination:
FI = tan -1 ( 2tan (lat))

Dipole field declination:
FD = 0.0

where "lat" is the latitude of the observation point.
GM-SYS defaults to values of 56,000 gammas, 60°,
and 20° for the magnetic field intensity, field incli-
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nation, and field declination, respectively.  This op-
tion may also be accessed from the Magnetic
Anomaly pane pop-up menu.

Set Azi./Strike Angle

Set the Profile Azimuth to correctly orient your model
with respect to the geomagnetic field.  Both positive
and negative entries are acceptable (e.g., a NW pro-
file azimuth may be represented by 315° or  -45°).

If your model strike is oblique to the profile azimuth,
the Relative Strike Angle must be set.  See Section
3.5 on Skewed Models for a description of the con-
ventions used in GM-SYS to describe the model
strike.  The default profile azimuth and relative model
strike are 90° (West to East) and 90° (orthogonal),
respectively.  The Set Azimuth/Strike Angle option
is also available in the Plan View pane pop-up menu.

Set Real-World Origin Coord.

GM-SYS uses a profile-based coordinate system, in
which the model and gravity/magnetic observation
points are located along a straight line.  Models cre-
ated from within Oasis montaj, using XYZGMS, or
by import using CVTGMS may have a coordinate
transformation associated with the model that allows
mapping of the profile coordinates to “Real World
Coordinates,” in which the profile origin (X=0, Z=0)
is assigned X,Y,Z coordinates.  Use this function if
you have created a model in another way and wish to
associate the profile coordinates to some other coor-
dinate system.  See the description of the ECS
(External Coordinate System) file for more de-
tails.

Set Plan View Depth

The Plan View Depth option allows you to numeri-
cally specify the depth of the horizontal slice through
the model which is presented in the upper pane as
the Plan View.  By default, the units used are those
of the Z-axis in the cross-section display.  You may
select different units by clicking the units box and
choosing from the pop-up submenu that appears.  The
Plan View depth may also be changed graphically

by using the Move Plan View Depth option in the
Cross Section pop-up menu.

Edit Anomaly

Activate the Anomaly spreadsheet editor by select-
ing the Edit Anomaly option.  Within the spreadsheet
editor, you may add or delete gravity and/or magnet-
ics stations, change the along-profile position (X) or
elevation (Z) of stations, or change the observed val-
ues at stations.  You may edit, copy, and paste cells
and add or delete rows (stations) or import new data
using the functions in the Edit Menu, which is vis-
ible when the spreadsheet editor is active.

Data to be imported must be in generic, space-de-
limited ASCII files.  Importing any new gravity or
gravity gradient data replaces all gravity and gravity
gradient data.  Importing any magnetic or magnetic
gradient data likewise replaces all magnetic and mag-
netic gradient data.

NOTE:  Since GM-SYS requires that gravity or mag-
netics stations exist at each point where gradients are
calculated, adding or deleting gravity or magnetics
stations produces a corresponding change in the re-
spective gradient components, and vice versa.

Edit Wells

This option provides an additional interface to the
Add/Config Wells option in the Overlay Menu de-
scribed in Section 5.1.3.  It is maintained for com-
patibility purposes.

Edit Blocks

GM-SYS 4.6 introduces the Block Parameter spread-
sheet. To activate the Block Spreadsheet, pull down
the Profile menu and choose Edit Blocks. The pa-
rameters for each block in the model are displayed
as a single row in the spreadsheet.  You may edit the
parameters and copy and paste one or many param-
eters from one block to another.  This allows you to
quickly and easily duplicate block parameters (copy
once, paste many) and perform quality-control on
your block parameters.  The Undo function does not
include changes to the Block Spreadsheet.  You must
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always perform a total recalculation of the model re-
sponse after making changes in the Block Parameter
spreadsheet.

Magnetics Elevation Adjust

Use this option to give all magnetics stations a con-
stant terrain separation.  The value entered is an ab-
solute height above topography; GM-SYS does not
add this value to the existing station elevations -- it
replaces them.  To move all stations to the topographic
surface, enter "0".  This function is useful for model-
ing a magnetic survey that is draped above the to-
pography.  This option is also available in the Mag-
netic Anomaly pane pop-up menu.

Magnetics DC Shift

This dialog allows the DC Shift to be applied in one
of three ways:

1) GM-SYS automatically calculates the DC Shift
value to minimize the RMS error ("Auto"),

 2) by forcing the calculated curve and the observed
curve to match at some user-selected reference
station (" Station#"), or

3) by explicitly subtracting a given value from the
calculated curve ("Absolute").  GM-SYS de-
faults to the "Auto" option.

In addition to entering a station number, you may
also force the curves to match at a station by placing
the cursor on an observed data point in the anomaly
pane (a green dot) and clicking the left mouse but-
ton.  All the calculated values will be shifted by the
amount necessary to make the calculated value and
the observed value agree at the station under the cur-
sor.  This station is indicated on the screen by two
vertical arrows above and below the selected point.
The point where the two values are the same can be
changed at any time by repeating the procedure.
The Magnetic DC Shift dialog is also available
from the Magnetic Anomaly pane pop-up menu.

Gravity Elevation Adjust & Gravity DC Shift

The Gravity Elevation Adjust and DC Shift options
operate identically to the corresponding Magnetics
options (see above).  They are also available from
the Gravity Anomaly pane pop-up menu.

5.1.6 Gradients Menu

The Gradients Menu controls
how gradient data in your
model are displayed and cal-
culated.  The Gradients Menu
is always present, even if your
version of GM-SYS is not configured to calculate
gradient responses.

Enable Grav. Gradients / Magn. Gradient

These options allow you to toggle on and off the dis-
play and calculation of all gravity gradients and the
magnetic gradient, respectively.  If GM-SYS is not
registered to include one or both of these options,
the unavailable option(s) will be "grayed-out" and
inactive.  If neither of these menu options is toggled
on, the following menu options will not be visible.

Gradient Axis

The Gradient Axis option displays a pop-up menu
that allows the user to toggle the alignment of the X-
axis for gradient calculations.  The X-axis defaults
to being coincident with the profile azimuth (PRO-
FILE).  The COMPASS option forces the X-direc-
tion in the gradient calculations to be due East (90°).
The Profile Azimuth (see Section 5.1.5) must be set
correctly, relative to True North, for this option to
function properly.

Edit Gradients…

The Edit Gradients…option activates the Anomaly
spreadsheet editor.  If the Enable Grav. Gradients or
Enable Magn. Gradients options are toggled on, tabs
will appear in the Anomaly spreadsheet editor which
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allow you to edit gradient data.  Within the spread-
sheet editor, you may add or delete stations, change
the along-profile position (X) or elevation (Z) of sta-
tions, or change the observed values at stations.  Stan-
dard Cut, Copy, and Paste functions are available
from the menu tool bar or the Edit Menu when the
spreadsheet editor is active.

NOTE:  Since GM-SYS requires that gravity or mag-
netics stations exist at each point where gradients are
calculated, addition or deletion of a station for any
gravity gradient component will produce a corre-
sponding change for Gz and all gravity gradient com-
ponents; and vice versa.  Similarly, the addition or
deletion of magnetic gradient station(s) will produce
a corresponding change in the magnetics stations.

Show Gravity Gradients/Magnetic Gradients

These options activate pop-up menus that allow you
to toggle on and off the display of observed data and
calculated response curves for individual gradient
components.  These options are also available in the
Gravity Anomaly and Magnetic Anomaly pop-up
menus if the Enable Grav. Gradients or Enable Magn.
Gradient options, respectively, are toggled on.

5.1.7 Action Menu

Commands available in the Action
Menu manipulate the geologic
model cross section.  All of these
commands are also available in the
Action Tool Box (shown at right),
with the exception of the Undo func-
tion (see below).  Only one of these
commands may be active at a time.
The active command is denoted by
a check mark in the Action Menu and
as a "depressed" button on the Ac-
tion Tool Box.  Pressing the right mouse button prior
to completion of an action will abort that action.

Undo

Select the Undo command to reverse the
action of any other command in the Action
Menu.  The Undo command is actually a

stack of operations; you may undo several operations
in reverse order of their occurrence.  Up to 10 opera-
tions may be "undone".  Undo does not update the
calculations.  Be sure to click on the calculate button
after a sequence of Undo commands.

The Undo button resides on the Menu Tool Bar in-
stead of the Action Tool Box  to reduce the chance of
undoing operations by accident.  Selection of the
Undo command does not change the selected action
in the Action Menu and Action Tool Box.

Move Point

The Move Point command allows the user
to relocate a single point.  Select the point
by pointing to it with the mouse cursor and

clicking the left mouse button.  Move the cursor to a
new location while holding the mouse button down,
then release the button.  If auto-calculation is enabled,
dynamic recalculation of the magnetic and/or grav-
ity response will occur as the point is being moved.
If multiple points lie within the search radius when
the button is pressed, GM-SYS will beep and an er-
ror message will appear in the status bar.  You may
need to zoom closer in order to isolate a single point.

In the Plan View pane, you may use the Move Point
mode to drag the ends of 2¾-D blocks and change
the strike length.  When cursor-tracking is enabled,
you may use this technique to drag the end of a block
in GM-SYS to match a feature in a map displayed in
Oasis montaj.



48

GM-SYS® v. 4.9

GM-SYS Interface
Move Group

The Move Group command allows you to
move any number of points the same direc-
tion and distance simultaneously.  Multiple

points may be selected for
movement using the Move
Group radio toggle box
(shown below) which ap-
pears when this item is se-
lected.  Points may be se-
lected or deselected for mov-
ing in any combination of
three ways:

Mark Point: toggle selection of individual points;
Mark Block:  toggle selection of all points defining

a block by clicking within a block; or
Mark Box: toggle all points within a window de-

fined by dragging the mouse.

To move the selected points, choose the Move Marks
option, press the left mouse button within the Cross
Section pane, drag the mouse in the desired direc-
tion, and release the button to complete the move.
The Move Group toggle box will disappear when a
different action is selected.

Add Point

Place the cursor on a surface where you wish
to create a new point and press the left mouse
button to create a new point.  If a point al-

ready exists within the search radius, GM-SYS will
beep and display a warning message and no point
will be added.  If the cursor is moved prior to releas-
ing the mouse button, the new point will follow the
cursor.  Release the left mouse button.  Dynamic re-
calculation of the magnetic and/or gravity response
will occur if autocalculation is enabled.

Delete Point

Place the cursor over the point to be deleted
and press the left mouse button.  If no point
is within the search radius when the button

is pressed, if the point is a triple-point, or if two or

more points are within the search radius, GM-SYS
will beep and display a warning message and no point
will be deleted.  If two or more points are within the
search radius, you must zoom in until a unique point
can be selected.  The point is deleted when the mouse
button is released.

Split Block

When the Split Block option is selected, the
initial button press on an existing point will
define the start of a new surface dividing a

block into two parts.  Subsequent button presses and
releases will define segments in the surface, until a
different, preexisting surface point (bounding the tar-
geted block) is chosen.  After each button press, a
"rubber band" line will appear from the last vertex to
the new cursor position.  The cursor position at but-
ton press becomes the next vertex.  The end of the
new surface must be an existing surface point on a
surface bounding the targeted block.  After the split
is completed, a block parameters box will appear to
allow modification of parameters for the new block.

Delete Surface

Place the cursor over a point on the surface
to be deleted and press the left mouse but-
ton.  A button release within the display area

is required for the deletion to actually occur.  Since
the targeted surface represents the boundary between
two blocks, one of the blocks must be deleted.  A
pop-up will appear that allows you to choose which
block to keep or to cancel the procedure.

Examine

The Examine function is context-sensitive.
When the Examine mode is selected from
the Action Tool Box or the Action Menu, a

left-button press within the Model Window starts the
Examine Point or Examine Block modes.

Examine Point

If a single point lies within the search radius when
the button is pressed, a dialog box showing the X-
and Z-coordinates of the point will appear.  This box
will allow the location of the point to be redefined.
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If two or more points are within the search radius,
GM-SYS will beep and display a warning message
and no point will be selected.  You must zoom in
until a unique point can be selected.

If the cursor is over a surface, but no point is within
the search radius, the Examine Surface command will
be initiated.

Examine Surface

Clicking the left mouse button on a surface between
points activates the Surface spreadsheet.  From within
the spreadsheet, you may edit the coordinates of the
points on the surface, add points, delete any or all
points except the endpoints, export the surface to an
ASCII XZ (profile coordinates) or XYZ (“real world”
coordinates) file, or import a new version of the sur-
face from an ASCII file.  Please note that the data
will be exported as a space delimited file and no
header information will be sent with data.

Prior to accepting the changes, GM-SYS checks to
ensure that the changes will not result in crossed sur-
faces.  If the changes are acceptable, they are incor-
porated into the model.  If not, an error message warns
of a problem and indicates the node which caused
the first error encountered.

Examine Block

Click the left mouse button when the cursor is within
a block in the Cross Section pane to activate the Block
Attributes dialog box.  Attributes (including fill color
and pattern) for the selected block may then be
changed.  Block attributes are described in detail in
the Model Elements section.

Box Zoom

After this mode is enabled, a button press in any of
the four display panes starts the Box Zoom
function.  Hold the mouse button down, drag
the mouse to draw a box around the area to
be viewed and release the mouse button.  The

pane will be resized to match the new limits.  The
horizontal limits of the other panes will be adjusted
to match those of the pane in which the box was
drawn.

2X Zoom In

After this mode is enabled, a button press in
any of the four display panes Zooms In on
the pane by about a factor of 2.  The hori-
zontal limits of  the other panes will be ad-

justed to match those of the pane in which the box
was drawn.

2X Zoom Out

After this mode is enabled, a button press in
any of the four display panes will Zoom Out
of the selected pane by about a factor of 2.

The horizontal limits of  the other panes will be ad-
justed to match those of the pane in which the box
was drawn.

Invert

The Inversion Setup dialog, shown at right,
is activated by selecting the Invert option
from the Action Menu or Action Tool Box.

Setting up the inversion entails three steps:

1) selecting the parameters to be freed for the in-
version,
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2) enabling constraints on the motion of points in

the X- and/or Z-Direction, if desired, and
3) setting the weighting ratio for the inversion be-

tween gravity and magnetics.

Inversion Setup

Up to 100 parameters may be
freed for inversion:  parameters
include the X-coordinate of a
point, the Z-coordinate of a
point, the density of a block, the
susceptibility of a block, and the
DC level.  To free the position
of a point, click on the

 of the Invert dialog
and select "X", "Z", or "XZ" (2
parameters!) from the pop-up menu.   Click the mouse
on the model point you wish to free.  The point is
replaced by a bar or bars oriented in the direction of
freedom.   In order to free block parameters, choose
density or susceptibility from the pop-up menu and
click on the block you wish to free.  A <d> or <s>
symbol will appear near the block label to indicate
that the density or susceptibility, respectively, has
been freed for that block.  Notice that when selected,
each item acts to toggle the parameter between free
and fixed.

Checking the Auto DC Level box allows the DC level,
or DC offset, to vary within the optimization pro-
cess.   Allowing the DC level to be free may allow
the optimization to fit the shape of an anomaly with-
out matching the DC level.  The "reference station"
does not change in the optimization process, so the
final " solution" may appear to be shifted from the
observed data.

Generally, when modeling a realistic geologic sec-
tion, the DC level should remain fixed.  Make sure
the "reference station" is not in the section of the
profile which you are trying to optimize.  As a gen-
eral rule, the fixed point should be near one end of
the profile, in a section where you are not changing
the geologic model.

The Clear All button fixes all model parameters, but
does not reset the Gravity:Magnetics weighting (see
below).

You may limit the distance that freed points may move
during each inversion iteration by checking the Con-
straints box and entering a maximum distance for
dX or dZ in the Constraints dialog box.  The check-
box to the left of the constraints button must be
checked in order for these constraints to take effect.
The units for each direction may be changed inde-
pendently, but default to the horizontal and vertical
units of the Cross Section pane.

The inversion defaults to give equal weight to the
gravity and magnetics calculations
(gravity:magnetics  = 0.5:0.5).  A value greater than
0.5 favors the gravity calculations; less than 0.5 fa-
vors magnetics.  To optimize for only gravity, use
1.0; for only magnetics use 0.0.

Go

Once the desired parameters are freed, selecting the
Go button initiates the first iteration of the inversion
computations.  The revised model and calculated re-
sponse curves are then displayed and the Iterations
dialog box is activated.  Fields at the bottom of the
Iterations dialog box report the change in the RMS
error for the gravity and magnetic response.  (Note:
the reported errors are calculated only for an "active
area" of the profile that may be affected by changes
being made to the model.)  Other GM-SYS functions
are disabled during the inversion/optimization pro-
cess.

The Next option initiates another inversion iteration.
Undo returns the model to its state prior to the last
step of the iteration.  Choosing the Accept option
terminates the inversion/optimization process.
GM-SYS then incorporates the changes into the
model, completes the inversion process, and closes
the Iterations dialog box.  Selecting Cancel rejects
all changes, returning the model to the state prior to
initiation of the inversion process, and closes the It-
erations dialog box.
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Inversion is a non-linear process with non-unique
solutions in most cases.  Inverting on the suscepti-
bility or density of a single block should result in
convergence after a single iteration.  Freeing the po-
sitions of multiple points and the properties of sev-
eral blocks may produce geologically unreasonable
solutions, even though the fit of the model response
to the data is good.  In general, it is better to free only
a few parameters at one time.  GM-SYS leaves the
interpretation of geologic "reasonableness" to you,
the interpreter.

Move Label

The Move Label option allows you to relo-
cate block labels and block attributes on the
Cross Section model for display or plotting

purposes.  When you select the Move Label option
from the Action Menu or the Action Tool Bar, a ra-
dio-toggle box allows you to choose between "Snap
mode" and "Drag mode".  In "Snap mode", clicking
the mouse with the cursor inside a block will move
the block label to that location with a zero-length
pointer.  To use "Drag mode", place the mouse cur-
sor at the lower left-hand corner of the block label
(not the block attributes) you wish to move and press
the left mouse button.  The block associated with the
label will be highlighted.  While holding the mouse
button, drag the label to the desired location.  The
end of the "pointer" line may be dragged in the same
manner.

5.1.8 Compute Menu

The Magn. Auto and Grav. Auto options toggle on/
off the autocalculation function
of GM-SYS.  When Autocalc is
on, GM-SYS calculates the
changing response of the model
in real time as you make
changes.  This is especially use-
ful when adding and moving a
point or moving a group of
points.  Most of the editing options in the Action
Menu and Action Tool Box support autocalculation.
The Undo option does not support autocalculation.

Selecting Magn. Total Calc. and/or Grav. Total Calc.
tells GM-SYS to perform a total recalculation of the
model response for the selected parameter the next
time the Calculate option is selected.  When these
options are not checked, the Calculate option (also
on the Menu Tool Bar) calculates the effects of
changes to the model.

If the Grid Output Option is licensed, the Calc.
Geosoft Grids item will appear at the bottom of this
menu.  Use this option to generate a grid response
from your models.

5.1.9 Window Menu

The Window Menu con-
trols the arrangement of
open model windows
within the Main Window.  The Cascade option ar-
ranges the open un-iconized model windows so that
all header bars are visible.  The Tile option arranges
and resizes all of the open, un-iconized windows so
as to totally fill the model space in the Main Window
with equally-sized open windows.  The Arrange Icon
option moves icons to the lower-left corner of the
model space in the Main Window.
The selection list allows you to choose which of the
open models (iconized or not) that you wish to have
in the foreground; i.e. make the active model.  The
active model is "checked".

5.1.10 Help Menu

Access the Table of Contents for
the online Help function for
GM-SYS with the Contents op-
tion.  The online Help may also be searched by key-
word.

About… will display version and registration infor-
mation about your copy of GM-SYS.
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5.2 MENU TOOL BAR
The Menu Tool Bar on the Main Window performs
some of the basic file handling, editing, and calcula-
tion functions.  Placing the mouse cursor over a but-
ton activates Balloon Help, which identifies the
button's function.  Four additional buttons follow the
usual file-handling functions.

5.2.1 Cursor tracking

When GM-SYS has been started from within OA-
SIS montaj, the two cursor-link buttons will be ac-
tive.  Either button may be toggled on, or both may
be off.  The left-most button causes GM-SYS to send
cursor position coordinates to Oasis montaj when-
ever the cursor is within a GM-SYS pane.  The sec-
ond button causes GM-SYS to send cursor coordi-
nates whenever the mouse is clicked within a pane.

5.2.2 Import/Export Horizon

In GM-SYS, a Surface is a sequence of two or more
contiguous nodes, which separates two blocks.  A
surface begins and ends at a triple-point, where three
surfaces intersect.  A Horizon consists of one or more
contiguous surfaces connected end-to-end (no
“branching”).

Import:

Press the ImpSurf button to import or digitize an ar-
bitrary horizon as a “floating” overlay on an existing
GM-SYS model.  You may add, move, or delete nodes
from the floating horizon.  You may extend either
end of the horizon to the nearest surface (up, down,
left, or right) or at “+infinity” or “-infinity” with a
mouse-click, without having to zoom out in order to
see the target surface.

While editing the floating horizon, the Action Toolbar
functions are disabled.  You may “Close” the Hori-
zon Import dialog at any time, leaving the floating
horizon visible while you edit your model, then re-
turn to the dialog by pressing the ImpSurf button
again.

When you have adjusted the horizon and the model
to your liking, click “Snap” to merge the floating
horizon with the existing model surfaces; nodes will
automatically be added where the horizon crosses
existing surfaces, while dangling ends will be re-
moved.  The horizon must intersect model surfaces
in at least two places in order to be incorporated into
the model.  Floating horizons not yet merged with
the model will be lost when the model is closed.

The imported file may contain either Profile (X,Z)
or Real-World (X,Y,Z) coordinates in space-delim-
ited ASCII format; the import function assumes that
the projection is the same as that of the model, as
specified in the .ECS file.  The floating horizon may
not cross itself.

Export:

Press the ExpSurf button to export a horizon.  Select
a sequence of contiguous surfaces to export and se-
lect either Export ProfileX to view and write an ASCII
file in profile coordinates, or Export RealWorld XY
to view and write the in Real-World (X,Y,Z) coordi-
nate system specified in the .ECS file.

5.3 MODEL WINDOW
A Model Window contains a single model opened
for editing.  GM-SYS allows multiple models to be
open at one time.  A Model Window consists of four
panes (from bottom to top):  Cross Section, Gravity,
Magnetics, and Plan View.  Sliding sashes between
the panes allow them to be resized or closed.  The
status of each Model Window is completely inde-
pendent of other Model Windows; each may be in-
dependently opened, closed, iconized, or resized.  El-
ements of a Model Window are described in detail in
the following sections.

5.3.1 Cross Section Pane

The Cross Section pane contains a view of the struc-
tural, geologic model.  The horizontal axis is anno-
tated across the top of the pane and the vertical axis
is annotated along the left-hand side of the pane.  The
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two axes may be displayed in different units.  Click-
ing the right mouse button on either axis activates a
pop-up menu to allow you to change units (see Sec-
tion 5.3.8.  A scaled bitmap image may be displayed
as a background layer.  Multiple symbol files may be
loaded and displayed as overlays to the Cross Sec-
tion pane.

5.3.2 Gravity Anomaly Pane

The Gravity Anomaly pane displays the observed and
calculated gravity anomalies, in milligals (mGal) or
micro-gals (µGal), for the portion of the model dis-
played in the Cross Section pane.  Toggle between
mGal and µGal by right-clicking on the Gravity Axis
and selecting Change Units.

Observed and calculated gravity gradients are also
displayed in this pane, if the Gravity Gradients op-
tion is enabled.  Gradients are displayed using the
same scale, in Eotvos units.  The display limits may
be changed by using the scroll bar, or by using the
Gravity Anomaly Axis pop-up menu and either en-
tering the limits explicitly or using the Autoscale fea-
ture.

5.3.3 Magnetic Anomaly Pane

The Magnetic Anomaly pane displays the observed
and calculated magnetic anomalies for the portion of
the model displayed in the Cross Section pane.  The
vertical axis units are gammas (cgs) or nanotesla (SI).
The observed and calculated magnetic gradient are
displayed in this pane if the Magnetic Gradient op-
tion is enabled.  The magnetic gradient is displayed
using the same scale, in either gammas/m or gam-
mas/km (cgs) and nanotesla/m or nanotesla/km (SI).
The display limits may be changed by using the scroll
bar, or by using the Magnetic Anomaly Axis pop-up
menu and either entering the limits explicitly or us-
ing the Autoscale feature.

5.3.4 Plan View Pane

The Plan View pane displays a horizontal slice
through the model at the specified Plan View depth.
Only display items that are turned on in the Cross

Section pane will appear in the Plan View pane (e.g.
wells, block fill).  The Y-axis of the Plan View may
be displayed using meters, kilometers, feet, kilofeet,
or miles and may use units different than those of the
X-axis, selected in the Cross Section pane.  Axis units
and limits may be changed using the Plan View Axis
pop-up menu.  Axis limits may also be modified us-
ing the scroll bar.

5.3.5 Scroll Bars

Scroll bars are located at the right-hand margin of
each pane in the Model Window and at the bottom of
the Cross Section pane.  The scroll bars allow you to
dynamically change the limits and scaling of each
pane.  A scroll bar is composed of two elements:  a
narrow black bar which represents the display limits
of the current "View" of the model, and an open box.
Click the mouse within the open box and drag it along
the scroll bar to slide the window along the axis with-
out changing the scale.  Click and drag one of the
ends of the open box to change the limit of that end
of the display window.  Changes to the display made
using the scroll bars are not automatically saved in
the Previous View stack.  Use the Mark Current View
option from the View Menu to add a view to the stack.

Axis scaling may be controled explicitly by specify-
ing the range and/or vertical exaggeration in the pane.
Right-click on any axis and select the Change Range
option to set these parameters.

5.3.6 Resizing Panes: Sashes

The border area between each of the panes in a Model
Window are sashes, which may be moved to resize
the panes.  To move a sash, position the mouse over
a sash so that the double-arrow cursor appears, press
the left mouse button, and drag the sash to its new
position.  The total size of the Model Window does
not change when sashes are moved.
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5.3.7 Balloon Help

Balloon Help is provided for all Menu Tool Bar and
Action Tool Box buttons.  Simply hold the mouse
cursor over a button for a second and a message will
appear adjacent to it describing its function.

5.3.8 Pop-up Menus

GM-SYS pop-up menus allow you to quickly and
efficiently edit model and display parameters for the
active model.  Clicking the right mouse button any-
where within a Model Window activates a context-
sensitive menu.  The pop-up menus encapsulate many
of the functions found in the Main Window menu
system described above, as well as additional func-
tions described in the following sections.  There are
nine pop-up menus and several secondary pop-up
menus available in an open Model Window.

All secondary pop-up menus are checklists, which
allow you to toggle display features on/off, activate
dialogs, or select axis units.

Axis pop-ups

Axis pop-up menus allow you to explicitly change
the axis scale, range, and or display units, as well as
the tick and axis label fonts.  Right-click on any axis
to view the options available for that axis.

The Change Range option presents a dialog that in-
cludes controls for vertical exaggeration and the num-
ber of decimal places used to display labels for that
axis (This value does not control the labels used in
printing.  See Section 6.4 for Print settings).

Cross Section Pop-up Menus

There are three primary pop-up menus available in
the Cross Section pane:  Horizontal- and Vertical-
Axis pop-ups and a Cross Section pop-up.  The axis
pop-ups for this pane are identical.  Each allows you
to change the units of the axis display and to set an
axis range by entering upper and lower limits in a
dialog box.  If you specify a vertical exaggeration,
GM-SYS recalculates the limits for that axis to gen-
erate the selected exaggeration.  Limits are entered

in the units specified for each axis, or they may be
changed from within the dialog.  Limits may also be
changed using the horizontal and vertical scroll bars.

The Cross Section pop-up allows you to change the
altitude at which the Plan View "slice" is taken
through the model.  Items in the Display sub-menu
are those found in the Display Menu which pertain
to the Cross Section pane.  Each may be toggled on/
off to customize the display of your models, both for
ease of use and for plotting purposes.  The Register
Backdrop submenu allows you to precisely register
a loaded backdrop image (see Section 5.1.3); this
submenu is grayed-out if the Seismic Bitmap Option
is not licensed.  TheSBR sub-menu allows you to
display the individual contribution to the total model
response produced by up to six blocks.  In order for
the response curves to appear, you must select Show
SBRs in the Display Menu.

Gravity Pop-up Menus

The Gravity Axis and Gravity Anomaly pop-ups may
be activated from within the Gravity Anomaly pane.
The Gravity Axis pop-up allows you to set the range
of anomaly values displayed within the pane, either
by explicitly entering the limiting values or by se-
lecting "autoscale".  The autoscale function adjusts
the scale and limits of the pane so that the observed
data points and calculated curve fill the anomaly pane.

The Gravity Anomaly pop-up contains options for
autoscaling the pane, editing the anomaly data (sta-
tion locations and observed values), Elevation Ad-
just, Set DC Shift, and a Display sub-menu that al-
lows you to toggle on/off the observed, calculated,
and error curves.  If gravity gradients are enabled, an
additional Display sub-menu is available.  When
Single Block Response is toggled on in the Display
Menu, an additional sub-menu is available that al-
lows you to toggle on/off the display of each block’s
response.

Magnetics Pop-up Menus

The Magnetic Anomaly pop-ups possess identical
functionality to the corresponding pop-ups available
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in the Gravity Anomaly pane, with the exception that
the Magnetic Anomaly pop-up has an additional op-
tion to allow you to Set Mag. Field.  If the magnetic
gradient is enabled, an additional Display sub-menu
is available.  When Single Block Response is turned
on in the Display Menu, an additional sub-menu is
available that allows you to toggle on/off the display
of each block’s response.

Plan View Pop-up Menus

The pop-up menu for the Plan View pane axis con-
tains options to Change Units in the ±Y direction,
scale the pane to a 1:1 View (scale is the same in the
X and Y directions), and an option to Change Range
in the ±Y directions.  The Plan View pane pop-up
contains the 1:1 View option, and options to set the
Plan View Depth and Set Azi/Strike Angle.

5.4 STATUS BAR
The Status Bar, located at the bottom of the Main
Window, provides information about the present sta-
tus of GM-SYS.  The bar is segmented into five fields.
The first field from the left and largest field reports
the present status of the mouse operation.  When se-
lecting commands from the menus, this field displays
the command function.  When performing one of the
editing operations from the Action Menu, this field
reports error information if an operation is used im-
properly or out-of-context.

The second field reports the current mouse opera-
tion selected from the Action Menu.

The third and fourth fields report the position of the
mouse cursor.  The third field displays the name of
the pane in which the mouse is moving and the fourth
reports the coordinates of the mouse cursor in the
units of that pane.

The fifth field reports the vertical exaggeration of
the Cross Section pane as presently displayed.



56

GM-SYS® v. 4.9

GM-SYS Interface



57

GM-SYS® v. 4.9

Printing a GM-SYS Model

6.  PRINTING A GM-SYS
MODEL
The GM-SYS Print option, found in the File Menu
and the Menu Tool Bar, allows you to print precisely-
scaled models to several common vector-graphics
formats or to one of the installed printers.  GM-SYS
internal drivers generate the following graphic for-
mats for printing or importing into external graphics
or image-processing applications:  Encapsulated
Postscript, Binary and Clear Text CGM (Computer
Graphics Metafile), Geosoft Plot (.plt), and DXF
(R12).

6.1 THE PRINT DIALOG
The Print dialog box displays the current configura-
tion of the model as it will appear on paper.  The
dialog is partitioned into three sections.  The left half
of the dialog displays a preview of the model layout,
showing the positions and sizes of the model panes,
titles, and axis labels on the printed page.  The up-
per-right section of the dialog shows the currently
active printer driver and allows you to select a dif-
ferent driver from a pop-up menu.  The active driver
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may be configured (page size, orientation, and some
driver-specific parameters) by clicking on the
Setup… button.  The lower-right section of the dia-
log displays the current scale and vertical exaggera-
tion of the plot and contains three buttons that allow
you to edit, save, and recall the specifics of the page
layout (fonts, scale, units, extents).  These options
are discussed in detail in Section 6.4.

Global Pattern scaling allows you to increase or de-
crease the size of all patterns displayed in your model.
This may be appropriate when printing to a large-
format plotter, when you want pattern elements to be
visible from a distance.

6.2 GM-SYS PLOT OUTPUT
OPTIONS
GM-SYS provides six internal drivers that produce
precisely-scaled, high-quality graphics files from
your models, for printing or importing into other
graphics and image-processing applications.  Win-
dows users may also use all of the installed print driv-
ers on the system.

6.2.1 Postscript

The Postscript driver produces generic encapsulated
postscript (EPS) files designed to be compatible with
most printers, plotters, and graphic applications, such

as Adobe Illustrator and Corel Draw.  This driver sup-
ports patterns, color fill, symbols, backdrop images,
and LAS well files.

6.2.2 Binary CGM

Output from this option will be a "Binary" Computer
Graphics Metafile (CGM) that may be sent directly
to a CGM print-queue or imported into another docu-
ment or graphics viewing program.  This driver sup-
ports patterns, color fill, symbols, backdrop images,
and LAS well files.

6.2.3 Clear Text CGM

Output from this option will be a "Clear Text" Com-
puter Graphics Metafile (CGM) which may be sent
directly to a CGM print-queue or imported into an-
other document or graphics viewing program.  This
driver supports patterns, color fill, symbols, back-
drop images, and LAS well files.

Table 6.1 Driver Capabilities
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6.2.4 Geosoft Plot (.plt)

The Geosoft .PLT output option will generate a
Geosoft PLT file and the associated attribute file.  This
file may be imported into MAP files in Geosoft's Oa-
sis montaj.  Solid color fill is supported in this driver.
Patterns are converted to solid colors.  Symbols and
LAS well files are supported.  Backdrop images are
not supported.

6.2.5 DXF

Output from this option will be a Release 12-
compatible.DXF file which may be read into any
CAD package that reads DXF files.  The DXF out-
put file contains several layers corresponding to the
various features of the plot.  This allows easy editing
of the file once it is imported into the CAD program.
Symbols and LAS well files are supported.  Raster
components such as patterns, color fill, and back-
drop images are not supported.

6.2.6 Raster Images

Use the Raster driver to generate high-quality im-
ages for inclusion in presentations, email, and web
pages.  Select the image resolution and the image
format.  This driver supports patterns, color fill, sym-
bols, backdrop images, and LAS well files.

6.3 PRINTER SETUP…
Choosing Printer Setup… activates the Printer Setup
dialog, which allows you to change paper size, ori-
entation, and any printer-specific settings.  You may
also enter the number of copies you wish to print.

6.4 SETUP PAGE LAYOUT
Selecting Setup Page Layout… activates the Plot Set-
tings dialog, which is comprised of six tabs for con-
figuring various aspects of your plot.  The tabs bring
each of the settings menus to the foreground in turn,
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allowing you to specify how the titles and axes in
each model pane will be plotted.  Fonts, scale, tick-
spacing, and units may be individually set for each
pane.

You may click the OK button to keep your changes
or Cancel to discard them and return to the Print dia-
log at any time.  Selecting the Apply button incorpo-
rates your changes into the model plot preview.
Choosing another  tab applies your changes and
moves to the next Settings menu.

6.4.1 Layout

The Layout settings control the general appearance
of the plot, including model titles, margins, fonts and
font attributes for titles, time/date and text annota-
tion.

6.4.2 Horizontal

The Horizontal settings determine the appearance of
the horizontal (X) axis of the plot.  You may change
the axis limits and units, set the axis scale or length
on the page, the tick and label intervals, as well as
the axis title and title font.  You may set the number
of decimal places to use in plotting your anomaly
labels (This is independent of the values used in the
model display). Check the include units box to ap-
pend the axis units to the axis title.

6.4.3 Vertical

The Vertical settings determine the appearance of the
vertical (Z) axis of the Cross Section pane on the
plot.  You may set the axis limits and units, the axis
scale, vertical exaggeration, or height on the paper,
the tick and label intervals, as well as the axis title
and title font.  You may set the number of decimal
places to use in plotting your anomaly labels (This is
independent of the values used in the model display).
Check the include units box to append the axis units
to the axis title.

6.4.4 Gravity

The Gravity settings control the appearance of the
Gravity pane on the plot.  You may set the axis lim-

its, the anomaly axis scale in mGal/paper unit, the
tick and label intervals, and the axis title and title
font.  You may set the number of decimal places to
use in plotting your anomaly labels (This is indepen-
dent of the values used in the model display).  Check
the include units box to append the anomaly units to
the axis title.

6.4.5 Magnetics

The Magnetic settings control the appearance of the
Magnetics pane on the plot.  You may set the axis
limits, the anomaly axis scale in gammas/paper unit,
the tick and label intervals, and the axis title and title
font.  You may set the number of decimal places to
use in plotting your anomaly labels (This is indepen-
dent of the values used in the model display). Check
the include units box to append the anomaly units to
the axis title.

6.4.6 Plan View

The Plan View settings determine the appearance of
the Plan View pane on the plot.  You may set the Plan
View axis (Y) limits and units, the aspect ratio of the
Plan View pane, the tick and label intervals, and the
axis title and title font.  You may set the number of
decimal places to use in plotting your anomaly la-
bels (This is independent of the values used in the
model display). Check the include units box to ap-
pend the axis units to the axis title.

6.5 PLOT PARAMETER FILE (.PPF)
Once you have modified the default settings in the
Page Layout dialog, you may save these settings for
later use in a Plot Parameter File (PPF) using the Save
Config option.  By default, this file is called
gmwin.ppf.  Later, you may choose to reload the PPF
file and use the same settings for subsequent plots.

The PPF file is an ASCII file which contains all of
the settings specified using the Page Layout dialog.
Although the file may be edited by hand, it is best to
change the settings from within GM-SYS to avoid
errors.
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7. GM-SYS MODEL

FILE FORMATS
A GM-SYS standard model consists of eight files
with the model name as the root and eight different
extensions:

<modelname>.sur Surface file
<modelname>.blk Block file
<modelname>.grv Gravity file
<modelname>.mag Magnetics file
<modelname>.vew View file
<modelname>.wel Well file
<modelname>.gms Workspace file
<modelname>.ecs External Coordinate Sys-

tem file
Other files which may be present are:

<modelname>.gdo Gravity gradient file
<modelname>.mdo Magnetic gradient file.

The first six model files are ASCII text files that de-
scribe the model.  They may be edited or altered if
care is taken to preserve the integrity of the model.
The .GMS file describes model-specific workspace
parameters.  The .ECS file contains information for
converting "Profile" coordinates (x,z) into "real-
world" coordinates (x,y,z).

The gravity gradient option creates one additional
ASCII file type, a .GDO file, which is analogous to
the .GRV file.  The magnetic gradient option also
creates an additional ASCII file type, the .MDO file,
which is analogous to the .MAG file.

If the .GRV, .MAG, .VEW, .GMS, .GDO, .MDO and/
or the .WEL files are not present, GM-SYS will build
default versions of those files when the model is
loaded.  Thus only the two files, .SUR and .BLK, are
required when building a model external to GM-SYS.

.ECS files are generated when GM-SYS models are
generated by CVTGMS or XYZGMS from external
model formats or XYZ data, respectively.

GM-SYS reads all ASCII values in a general format.
The number of entries per line must match the ex-
amples and each entry should be separated by at least
one space.  The format of numbers given in the ex-
amples need not be strictly followed.  The forms
123.4, 1.234E2, and 0.1234000E+003 will all be read
equivalently.  .GSR, .MSR, .GDR, and .MDR binary
files generated by earlier versions of GM-SYS are
no longer used and may be discarded.

Note:  With the exception of the Origin in the .ECS
file, all distances in GM-SYS model files are in kilo-
meters, with the Z-axis positive down (depth).

File Format Changes:
Beginning in GM-SYS version 4.6, extensions have
been introduced to the .BLK, .SUR, .ECS, and .GMS
file formats to support additional content (e.g. Sym-
bol and LAS well files). By default, GM-SYS uses
the newest  formats when saving a model.

Earlier versions of GM-SYS will read models cre-
ated with newer versions, but will lose block color/
pattern information and may fail to load large mod-
els.  Newer features, such as loaded symbol and
bitmap files, custom colors,  projection and coordi-
nate transform info, and color tables may not appear
in older versions of GM-SYS.  Modifying these mod-
els in older versions of GM-SYS will generally cause
this information to be lost.
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7.1 SURFACE (.SUR) FILE FORMAT
The surface and block files describe the geologic
model. The surface file defines the surfaces in the
model.
Line 1:  The first line of this file should contain:

1) the azimuth of the profile in degrees,
2) a flag value (128),
3) the model strike angle (degrees from north),
4) GM-SYS model-format version number

Line 2:  The second line contains three integer
flags that represent the units used for the depth (Z),
distance (X), and plan view (Y) axes of the model
respectively.

1) depth (Z) unit flag,
2) distance (X) unit flag, and
3) plan view (Y) unit flag.

The flag values for the units are:
1 = Km
2 = meters
3 = feet
4 = Kilofeet
5 = miles

Note:  distances are always stored in the file as kilo-
meters.  Unit flags control only the display.

Surface groups:  Beginning on the third line and con-
tinuing to the end of the surface file are the data for
the individual surfaces.  A single surface is repre-
sented by a group of 7 or more lines of data. There
can be a maximum of 300 surfaces in the Profes-
sional Edition and 750 surfaces with the Extended
Model option.

Line 3:  The first line of each group consists of a
single integer, the surface number (Allowable range:
1-750).

1) surface index number

Line 4:  The second line of each group consists of
two integers, the index of the left and right blocks

sharing this surface, respectively. (Allowable range
for block index numbers: 1-300.)

1) index number of left block,
2) index number of right block.

Starting at the first point on the surface and traveling
through the succeeding points to the last point, the
block on your right is the right block and the block
on the left is the left block.  Thus, if a vertical surface
went from bottom to top, then the left block would
be on the left-hand side of the model; whereas if the
vertical surface went from top to bottom, then the
left block would be on the right-hand side of the
model.

Line 5:  The third line of the group contains four
Boolean flags (0 or 1):

1) gravity model changed flag,
2) magnetic model changed flag,
3) surface deleted flag, and
4) reserved for future use.

The model changed flags indicate that surface has
been changed since the last calculation, and its re-
sponse must be recalculated.

For models constructed external to GM-SYS, these
four flags should all be set to 0.

Line 6:  This line is not used or updated by GM-SYS
versions 4.0, but is maintained for backward com-
patibility.  It contains four real numbers representing
X and Z limits of the surface:

1) the minimum value of X,
2) the maximum value of X,
3) the maximum value of Z, and
4) the minimum value of Z.

Note that z is positive downward.

Line 7:  A single integer then occurs on the next
line of the group which is the number of points in
the surface. (Allowable range: >1)
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1) number of points in surface

 Line 8:  The remaining lines of the group contain
coordinates for each point in the surface.

1) X coordinate (kilometers),
2) Z coordinate (kilometers, positive down).

Since a surface must have at least two points, this is
how the minimum of seven lines per surface is ar-
rived at: two lines will represent the two points.  Be-
ginning with version 4.6, GM-SYS no longer
breaks long surfaces into segments of 17 points
or fewer.

Last Line:  The end of the surface file is marked by
a line containing a single integer equal to -999.

1)  -999

7.2 BLOCK (.BLK) FILE FORMAT
The block file consists of four lines of data for each
block in the model.
Block groups:  There can be up to 300 block
groups with four lines for each block.

Line 1, 5, :  The first line of a block contains the
block index number and a flag which controls
display of the block label.  The block number must
be referenced in at least one surface group in the
surface file.

1) block index number, and
2) label display flag.

Line 2, 6, :  The second line is the name of the
block.  This is a character string which may contain
spaces.  It should not be in quotes.

1) block name.

Line 3, 7, :  The third line consists of at least 5
entries; 9 entries are present if the block is 2 ¾-D.

The parameters are:
1) the block density,
2) the inclination of the remanent magnetization,
3) the declination of the remanent magnetization,
4) the susceptibility,
5) the intensity of remanent magnetization,
6) the maximum Y length,
7) the minimum Y length,
8) the density beyond the maximum Y,
9) the density beyond the minimum Y,
10) the susceptibility beyond the maximum Y,
11) the remanent magnetization beyond the maxi-

mum Y,
12) the inclination beyond the maximum Y,
13) the declination beyond the maximum Y,
14) the susceptibility beyond the minimum Y,
15) the remanent magnetization beyond the mini-

mum Y,
16) the inclination beyond the minimum Y,
17) the declination beyond the minimum Y.

Line 4:  The fourth line of a block consists of four
entries defining the X and Z coordinates of the
block label and the X and Z coordinates of the
label arrow.  A fifth entry describes the pattern,
foreground/background colors and block transpar-
ency.  Two additional entries describing these
parameters for the +Y and -Y blocks are present if
the block is 2 ¾-D.

1) X coordinate of the block label,
2) Z coordinate of the block label,
3) X coordinate of label pointer,
4) Z coordinate of label pointer,
5) hexadecimal block pattern/color fill specifier

#PPRRGGBB/#TTRRGGBB,
6)  block pattern/color fill specifier for +Y block,
7)  block pattern/color fill specifier for -Y block
7)  velocity for the block
7)  velocity beyond the maximum Y,
7)  velocity beyond the minimum Y.

The PP characters specify one of 40 possible pat-
terns;  subsequent RRGGBB defines the block fore-
ground color.  The TT characters are set to “01” if
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the block is transparent, “00” otherwise.  The second
RRGGBB triplet describes the block background
color.  Note that a block may have a background color
defined, but have transparency enabled.

Last line:  As with the surface file, the end of the
block file is denoted by the line containing the inte-
ger -999.

1) -999

7.3 GRAVITY (.GRV) FILE FORMAT
Line 1:  The first line of the gravity file contains
four integers that determine the method used to
calculate the DC Shift when displaying calculated
gravity data.

1) station number for offset calculation; zero if "Sta-
tion" option is not used;

2)  reserved;
3) absolute offset, in mGals; zero if "absolute"

method not used or if no offset is used;
4) "Auto" mode; "1" if this method is used, "0"

otherwise.
Line 2:  The second line also consists of a single
integer representing the number of stations in the
file.  (Allowable range: 1-1000)

1) number of stations in the file.

Following lines:  Following the number of stations
is a line for each station.

Line 3:  For each gravity station there is a line with
four entries (all distances are in kilometers, with z
positive down):

1) the X coordinate of the station, in km,
2) the Z coordinate of the station, in km,
3) the observed gravity value at the station, in

mGals, and,
4) the calculated gravity response at the station due

to the model (which initially should be zero).

Last line:  End of File marker.
 1) -999

7.4 GRAVITY GRADIENT (.GDO)
FILE FORMAT
The gravity gradient file is analogous to the gravity
file described above but may contain comment lines
that begin with *.

Line 1:  The first non-comment line consists of a
single integer representing the number of stations in
the file.  (Allowable range: 1-1000)

1) number of stations in file.

Line 2:  The second non-comment line consists of
six Boolean flags (0 or 1).  These flags should be set
to 1 for models constructed external to GM-SYS.

1) Boolean flag.

Line 3:  The third non-comment line consists of six
additional Boolean flags (0 or 1).  These flags should
be set to 1 for models constructed external to
GM-SYS.

1) Boolean flag.

Following lines:  Following these lines is a line for
each station.

Line 4:  For each gravity station there is a line with
fourteen entries (all distances are in kilometers, with
z positive down):

1) X-coordinate (in km)
2) Z-coordinate (in km)
3) Gzx observed (in Eotvos units)
4) Gzx calculated (in Eotvos units)
5) Gzy observed (in Eotvos units)
6) Gzy calculated (in Eotvos units)
7) Gzz observed (in Eotvos units)
8) Gzz calculated (in Eotvos units)
9) Gxx observed (in Eotvos units)
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10) Gxx calculated (in Eotvos units)
11) Gyy observed (in Eotvos units)
12) Gyy calculated (in Eotvos units)
13) Gxy observed (in Eotvos units)
14) Gxy calculated (in Eotvos units).

GDO files written by GM-SYS contain additional
information at the end of the file, regarding the num-
ber of surfaces and the (re)calculation status of each
surface.  If this information is not present, GM-SYS
assumes all surfaces require recalculation.

7.5 MAGNETICS (.MAG) FILE
FORMAT
The magnetics file is similar to the gravity file but
contains an extra line with the Earth's magnetic field
parameters.

Line 1:  The first line of the magnetics file contains
four integers that determine the method used to cal-
culate the DC Shift when displaying calculated mag-
netic data.

1) station number for offset calculation; zero if "Sta-
tion" option is not used;

2)  reserved;
3) absolute offset, in gammas; zero if "absolute"

method not used or if no offset is used;
4) "Auto" mode; "1" if this method is used, "0"

otherwise.

Line 2:  The second line also consists of a single in-
teger representing the number of stations in the file.
(Allowable range: 1-1000)

1) number of stations in the file.

Line 3:  The third line contains the values for the
Earth's magnetic field:

1) inclination,
2) declination and
3) total magnetic field strength (gammas).

Following lines:  Following the magnetic field pa-
rameters is a line for each station.

Line 4:  For each magnetics station, there is a line
with four entries (all distances are in kilometers, with
Z positive down):

1) the X coordinate of the station,
2) the Z coordinate of the station,
3) the observed magnetic anomaly at the station,
4) the calculated magnetic response at the station

due to  the model (which initially should be zero.)

7.6 MAGNETIC GRADIENT (.MDO)
FILE FORMAT
The magnetic gradient file is analogous to the mag-
netics file described above, but may contain com-
ment lines which begin with *.

Line 1:  The first non-comment line consists of a
single integer representing the number of magnetics
stations in the file.  (Allowable range: 1-1000)

1) number of stations in file.

Line 2:  The second non-comment line consists of a
single Boolean flag (0 or 1).  The flag should be set
to 1 for models constructed external to GM-SYS.

1) Boolean flag.

Line 3:  The third non-comment line consists of a
single Boolean flag (0 or 1).  The flag should be set
to 1 for models constructed external to GM-SYS.

1) Boolean flag.

Following lines:  Following these lines is a line for
each station.

Line 4:  For each magnetics station, there is a line
with four entries (all distances are in kilometers, with
Z positive down):

1) X-coordinate (in km),
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2) Z-coordinate (in km),
3) Btz observed (in gammas/meter),
4) Btz calculated (in gammas/meter).

7.7 VIEW (.VEW) FILE FORMAT
Views are generally created by the user during inter-
action with GM-SYS, but each model is initially cre-
ated with two default views.  Each view consists of
five lines:

Line 1:  View number
Line 2:  View Name
Line 3:  Model Window Limits:

1) Minimum X-coordinate of view,
2) Maximum X-coordinate of view,
3) Maximum depth of view,
4) Minimum depth of view.
5) Plan View depth.

Line 4:  Gravity Anomaly Window Limits:
1) Minimum X-coordinate of view,
2) Maximum X-coordinate of view,
3) Minimum anomaly value in view,
4) Maximum anomaly value in view,
5) Minimum Y-coordinate in Plan View.

Line 5:  Magnetic Anomaly Window Limits:
1) Minimum X-coordinate of view,
2) Maximum X-coordinate of view,
3) Minimum anomaly value in view,
4) Maximum anomaly value in view,
5) Maximum Y-coordinate in Plan View.

Last line:  end-of-file flag

1) -999

7.8 WELL (.WEL) FILE FORMAT
Wells are used as a type of annotation, but are not
used in the computations by GM-SYS.  By display-
ing a well, you may show various horizons, or
changes from one type of material to another.  This
data may come from well logs, core samples,
magnetotellurics, resistivity studies, geologic maps,

or any other source that you may have.  Wells allow
you to display on screen all of the geological and
geophysical constraints of the model.

The description of each well consists of a well name,
location, and the depth (not elevation) and annota-
tion for each horizon (0 to 10).  Entries in the first
four lines are required; the others may be left blank.
GM-SYS allows up to 20 wells per model.  The last
well entry must be followed by a line containing only
an end-of-file flag (-999).

Line 1:  1st Well name
Line 2:  X-coordinate (km), well symbol name
Line 3:  Z- and Y-coordinates (km),

(Z positive downward)
Line 4:  Number of horizons
Line 5:  Depth to 1st horizon (km)
Line 6:  Name of 1st horizon (optional, may be left
blank)
Line 7:  Depth to 2nd horizon (km)
Line 8:  Name of 2nd horizon
.
.
Line 23: Depth to 10th horizon
Line 24:  Name of 10th horizon
Line 25:  End of file flag (-999) or 2nd Well name.

7.9 GMS (.GMS) File Format
The GMS file organizes some of  the extended fea-
tures of  the GM-SYS model.  Model-specific set-
tings, such as custom colors, display units, and the
relative sizes of  the Cross Section, Anomaly, and
Plan View panes are stored in this file.  Information
about external files used with the model, such as the
name, location, and registration of a backdrop im-
age, the names and configuration settings of symbol
and LAS well files, loaded color tables, etc., are stored
here.

The general format of the .GMS files is similar to
that of an INI file.  Section headings are denoted by
square brackets and are followed by one or more lines
of the form:



67

GM-SYS® v. 4.9

GM-SYS Model File Formats
[HEADING1]
variable_name1=value1
variable_name2=value2

7.10 EXTENDED COORDINATE
SYSTEM (.ECS) FILE FORMAT
The ECS file contains information describing the ori-
entation of the model in 3-D space, in the form of a
coordinate transformation from 2-D (profile) to 3-D
(real world) coordinates.  Note:  The X, Y, Z values in
the Origin are stored in the native (original) units of
the data used to create the model.  These are the only
coordinates in GM-SYS model files that are not stored
in kilometers.  Models created using XYZGMS 1.04
and later  will include this information.  Models built
from within OASIS montaj also include a section with
the Geosoft projection information if the database or
grid files from which the model was built contain
projection information.   Models imported as 3-D
DXF files through CVTGMS also contain coordi-
nate transformations.

[XYZ.ECS]
@SECTION=XYZ.ECS
  Origin=X Y Z // Profile 0,0
  CosTheta= // Theta=Azimuth
  SinTheta=
  Scale= // 1/units2km

@SECTION=Geosoft.Projection
  Projection=
  Datum=
  Method=
  Unit=
  Local=

7.11 GENERIC SPACE-DELIMITED
ASCII
GM-SYS utilizes a generic, space-delimited ASCII
format for model files, imported and exported data
and horizon files, and symbol files.  Internally, all
distances are stored in kilometers.  Observed and cal-
culated values are stored using cgs units.

GM-SYS expects imported files (e.g. anomaly data
files, symbol location files) to be space-delimited
ASCII, as well,  but units are not restricted to kilo-
meters and cgs.  Use the pull-down menus in the im-
port dialogs to specify the units used in your files.

7.12 SYMBOL DEFINITION FILE
The symbol definition file, gmwin.sdf, is a library
of predefined symbols that may be mapped to flag
values in the symbol files.  A separate “Wells” group
defines well-head symbols for use with well mark-
ers or LAS well files. You may add symbols to this
file as long as you adhere to the format.  Note that
subsequent installations of GM-SYS may overwrite
this file, so you may wish to maintain a backup copy.

// Symbol Definition File
// Unit = 1/720"
//
//  DPI <dpi>       ; default DPI
//  RefSymSize <refsymsize>  ; (Optional) default
// symbsize.

DPI  1200  // dot per inch (default DPI=1.0)
RefSymSize  150  // default symbol size

// index 1 diamond
DefSymbol diamond
  MoveTo   0  85
  LineTo  85   0
  LineTo   0 -85
  LineTo -85   0
  LineTo   0  85
EndDef

// index 2 +
DefSymbol  plus
  MoveTo    0  85
  LineTo    0 -85
  MoveTo  -85   0
  LineTo   85   0
EndDef
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7.13 PATTERNS
GM-SYS has the capability to utilize vector patterns
for display and plot output.  If you have Geosoft’s
Oasis montaj installed on your system, GM-SYS will
use some of the patterns from “default.pat” file for
use as GM-SYS block fill.
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CVTGMS is a file conversion utility designed to
generate GM-SYS model files from digitized geo-
logic models, DXF, IHF & Card Image 7 export files,
and GMA, LCT, & SAKI model files.  By default,
CVTGMS will read and write GM-SYS model files,
allowing you to shift or decimate your models.  If
the model-conversion option has been licensed,
CVTGMS will import and export  all supported
model files and formats.

CVTGMS is installed automatically with GM-SYS.
A CVTGMS icon will be placed in the  Utilities
submenu of the GM-SYS Program Group in the Start
Menu.

The CVTGMS main window consists of a menu bar
and two scrollable panes:  an upper model pane which
graphically displays the input model, and a lower
progress pane which provides a log of operations
performed on the model.

8.1 GETTING STARTED
Start CVTGMS by double-clicking on the CVTGMS
icon in the Start Menu.  CVTGMS may also be started
from within Oasis montaj, using either the GM-SYS
Menu or the GM-SYS toolbar.  Use the File Menu to
open the file-selection dialog.  You may now select
the file-type and file you wish to convert.  The de-
fault file-type is GM-SYS (*.sur); the other file types
will be available if CVTGMS is licensed.
Note:  You must choose the correct file type for the
input file from the pull-down menu.  Simply typing
the new extension will cause CVTGMS to attempt
to read the file with the wrong filter and the
operation will abort with an error.

8.1.1 Modifying the model

After reading the input file, CVTGMS displays a plot
of the model in the upper pane of the window with a
dashed red line showing the model "limits" read or
calculated from the file.  The model limits are either
explicitly supplied, as in a DIG file, generated from
the "Full" view, as in a GM-SYS model, or calcu-
lated by CVTGMS from the input model extents.  One
or more green lines within the limits define the sur-
faces of the model.  The lower pane will display a
log of operations performed on the model.

If the plot appears "upside down," choose Flip over
Z from the Execute menu to change the sense of the
Z-axis.  At this time, you should also check that the
units are appropriate for each axis (Execute Menu |
Alter Unit).  You may also specify a lateral- (along-
profile) or depth-shift and/or reverse the direction of
the profile at this time.  If the input file is of type
DIG or DXF, you may also set the default block pa-
rameters at this time.  DIG, XYZ, DXF, IHF, & Card
Image 7 input files must also be "Snapped" prior to
output (see Section 8.3.2 for a description of this func-
tion).

CVTGMS will also Decimate files prior to output.
This function is particularly useful when the input
file is either a seismic model (e.g. GMA) or a digi-
tized model which contains many points along nearly
straight surfaces.  The Decimate function may dra-
matically reduce the number of points in the model
without sacrificing the quality of the model, which
will increase the calculation speed of GM-SYS.
Choose a "straightening tolerance" that is appropri-
ate to your model.

8. CVTGMS
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8.1.2 Output

When all of the parameters have been set to your
satisfaction, choose Save As... from the File menu
and select the file-type you with to create as output.
The default file-type is GM-SYS (*.sur).  Choose an
output file name - make sure the file-extension is in-
cluded - and click OK.  A message in the lower pane
will indicate that the file has been saved.

8.2 MENUS

8.2.1 File Menu

Erase Model

This command will remove the currently-loaded file
from memory, unconditionally and without saving.

Open...

The Open... command activates the file-selection dia-
log.  Here the user may select the file and file-type to
be used as input.  Allowable file-types are displayed
when the List Files of Type pull-down menu is se-
lected.  The default file-type is GM-SYS with the
default extension ".sur".  Other files types which may
be available include:

•  AutoCAD DXF (.dxf);
•  2D (X,Z) and 3D (X,Y,Z) ASCII files (.dig, .xyz);
•  LCT, Inc.'s 2-MOD (.lct);
•  Geophysical Micro Computer Appl., LTD. (.gma);
•  GeoSec IHF (.ihf);
•  GeoQuest Card Image 7 (.dat);
•  Chevron's GAMMA (.gam), and
•  US Geological Survey's SAKI (.cmd).

If these other file types do not appear in the “Open
File” dialog, the CVTGMS conversions are not li-
censed.

IMPORTANT:  Although each file-type has a default
extension (e.g. ".dig"), the user may select a differ-
ent extension for a given file type (e.g. ".txt").  How-
ever, changing the default extension does not alter

the expected file format.  Therefore, changing the
extension to ".dig" when the List Files of Type selec-
tor is set to DXF Files (*.dxf) will result in an error
because CVTGMS is expecting a file of type "DXF".
Because GM-SYS uses specific file extensions for
its models, we recommend that the default file type
".sur" always be used when reading or creating
GM-SYS models.

Save As...

The Save As... dialog allows the user to save the con-
verted model in any of the available formats.  Avail-
able formats are displayed when the List Files of Type
pull-down is selected.  Again, with the exception of
GM-SYS model files, a file may be saved with an
alternate extension if desired.

Exit

Exit CVTGMS unconditionally, without saving any
loaded file.

8.2.2 Execute Menu

Set Block

When creating a GM-SYS model from DIG or DXF
formats, the Set Block dialog allows you to set the
default block parameters for the "Air" block or other
blocks.  These parameters include density, magnetic
susceptibility and remanent magnetization, and the
±Y-extent of  the block(s).

Alter Unit

The Alter Unit dialog allows the user to independently
change the X or Z units of the model.  Available units
include kilometers (km), meters (m), feet (ft), kilofeet
(kft), and miles (mi).

Shift XZ...

The Shift XZ... dialog permits the user to shift the
model laterally (along the profile) and/or in depth.
The amount of shift to be applied must be entered in
units of kilometers (km).
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Flip over X

This command reverses the model profile direction.

Flip over Z

This command flips the model upside-down.

Decimate dialog

CVTGMS allows the user to decimate superfluous
points on surfaces using a "straightening tolerance"
entered by the user.  Points along a surface which
deviate from a straight line by less than the straight-
ening tolerance are deleted, thereby decreasing the
number of points in the model.  Better results are
generally achieved if decimation occurs the Snap...
command (see below), when necessary.  The straight-
ening tolerance must be entered in kilometers.

Snap... (DIG, XYZ, IHF, & DXF inputs only)

In order to produce a valid GM-SYS model, surfaces
must be continuous across the model and nodes
should exist where surfaces cross.  Digitized hori-
zons and DXF files do not inherently satisfy these
conditions.  When you ask CVTGMS to Snap... a
DIG, XYZ, IHF or DXF file, it will calculate a de-
fault "snap distance" based on the minimum point
separation of the input file.  CVTGMS will "snap"
points together (i.e. force the points to be coincident)
that miss by the snap distance and create new points
where surfaces cross.  The snap will force any un-
snapped endpoint to snap to the nearest point.  Gen-
erally the "snap distance" should be kept small.  If
the input model has no closely spaced points you may
want to decrease the default snap distance. You may
need to fine tune this parameter to get your desired
output model.

The Snap... command also performs several addi-
tional "clean-up" functions.  Surfaces which extend
beyond the "limits" are truncated at that boundary.
"Hanging" surfaces which do not connect to another
surface or extend to the limit box are extended to the
nearest limit (vertically or horizontally).  Overlap-
ping surfaces are either separated or combined, ac-
cording to the "snap distance."  Finally, surfaces are

extended laterally from the model limits to "infinity"
(± 30,000 kilometers).  The model surfaces and points
will change color as different operations are per-
formed and completed.  Each task will be logged in
the lower pane, along with any errors in the event
that any occur.

Assign Block Names... (DIG , XYZ  & IHF inputs only)

The Assign Block Names function utilizes surface_id
strings in .DIG and .XYZ files and Horizon names
in IHF files to produce block names.  It assumes that
each horizon defines the top of a body and the name
is assigned appropriately.  Blocks for which names
are not able to be assigned will be named “unlabeled”
and a default hatch pattern will be assigned to the
block for easier location in GM-SYS.  Horizon names
that are not used will be written to a log file.

Remove micro-blocks...

“Micro-blocks” describes relatively tiny, usually tri-
angular blocks created when the Snap... command
connects surfaces which overshoot by more than the
“snap distance”.  The Remove micro-blocks... func-
tion removes all of the triangular (3-point) blocks
which are smaller than a user-defined threshhold.
Blocks with an area smaller than a specified percent-
age of the total “Full View” area will be removed
from the model.

8.2.3 Views

GM-SYS allows the user to save multiple named
"views" -- screen views or windows -- of each model.
A view is defined by the current X and Z limits of
the model and the current gravity and magnetic lim-
its of the anomaly windows.  Views are useful in re-
turning to a specific portion of the model at a later
time.

Full View

The default or "Full" view includes the full extent of
the profile to be modeled.  The Full view is created
by CVTGMS from the model limits of the input file.



72

GM-SYS® v. 4.9

CVTGMS
Infinity

The "Infinity" view includes the entire GM-SYS
model, which extends to "infinity" (±30,000 kilome-
ters in either direction) to eliminate edge-effects.

Other - only GM-SYS input

If a GM-SYS model is being used as input, any of
the views present in the .vew file may be selected to
limit the extents of the output model.

8.2.4 Help

CVTGMS on-line help accesses the WinHelp screen.
More recent documentation may be found in the
HTML help accessed from within GM-SYS.

About...  brings up the registration screen, which con-
tains licensing information, the version of CVTGMS
being used, and customer support information.  There
are no user-changeable options in this window.

8.3 FILE FORMATS

8.3.1 2-D DIG & 3-D XYZ Generic ASCII file

These are space-delimited, free-format ASCII files
which contain one or more digitized or exported ho-
rizons.

1)  2D (X,Z) coordinates (“DIG” format) and
2)  3D (X,Y,Z) coordinates (“XYZ” format).

These files begin with two “limit” points, which de-
fine a bounding square (DIG) or box (XYZ) by speci-
fying two points at opposing corners.  Horizons which
extend beyond these limits are truncated, then ex-
tended to “Infinity” to eliminate edge effects.  The
initial “Full View” for GM-SYS is also calculated
from these limit points.

Each line in the file following the “limit” points de-
fines a node on a horizon and must consist of coordi-
nates and a surface-id string. The surface-id string
must be a string of letters and/or numbers (no spaces
or commas) which uniquely identifies the surface.

CVTGMS interprets each change in the surface-id
string as the beginning of a new surface.  The Assign
Block Names function can utilize the surface-id string
to generate names for most blocks.  CVTGMS ig-
nores comment lines beginning  with "/", "*", or "#".

For output, CVTGMS creates unique surface-id
strings from the block numbers on either side of the
surface.  No additional block information is retained
in the output .DIG or XYZ file.

Two-dimensional .DIG file

/Sample DIG  input file
/     X       Z    Surface-ID
 123.947 -555.693 limits # X1,  Z1, "limit"  - Lower left

(or upper right) limits of the model
 1509.401  -30.572 limits # X2,  Y2, "limit"  - Upper right

(or lower left) limits of the model
  442.271 -313.329 1st_surf # X, Z, "surface-id"   - X and Z

of points on surface
  346.609 -329.817 1st_surf
  234.453 -349.601 1st_surf
  123.947 -365.382 1st_surf
  480.206 -179.782 2nd
  396.09  -204.513 2nd
  305.375 -227.595 2nd
  194.869 -245.731 2nd
  123.947 -254.821 2nd
  734.206     -221 3rd
  694.622 -222.649 3rd

Three-dimensional .XYZ file

The format of the .XYZ file is similar to the .DIG
file described above, but includes Y-coordinates for
each point.

/Sample CVTGMS input .XYZ file
X1 Y1 Z1 Limits
X2 Y2 Z2 Limits
X Y Z Horizon_name1

.

.
X Y Z Horizon_name1
X Y Z Horizon_name2

.

.
X Y Z Horizon_name2
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For three-dimensional .XYZ input files, CVTGMS
transforms the "real world" 3-D input coordinates into
2-D "model-space" coordinates for GM-SYS.
CVTGMS uses the X, Y coordinates from the two
"Limit" points at the beginning of the file to define a
straight line in the Z=0 plane.  CVTGMS then
projects the X,Y coordinates of each point in the file
onto that line to calculate the model-space X-coordi-
nate.  The model-space X=0 location corresponds to
the "limit" point with the smallest X-coordinate.  The
model-space Z-coordinate is equal to the real world
Z-coordinate.  CVTGMS retains the transformation
coefficients in a .ECS file which is associated with
the model so that model space coordinates can be
transformed back to real world coordinates.

Output in the .XYZ format is similar to the .DIG file,
with the exception that any transformation informa-
tion saved in the .ECS file is used to recalculate X,Y
coordinates from the model-space X coordinates.
CVTGMS assumes that the output profile is a straight
line in X,Y-space; i.e. it can not "unproject" the points
from the straight line if they were originally non-
linear.

8.3.2 DXF - AutoCAD®

AutoCAD DXF files must specify 2D or 3D
polylines.  The ENTITIES SECTION should con-
tain several POLYLINES which CVTGMS converts
to surfaces.  Model limits are calculated from the
minimum and maximum coordinates of the polylines.

 "Elevation" and "Extrusion" information contained
in the DXF file are saved in a .ecs (External Coordi-
nate System) file.  When a GM-SYS model is con-
verted back to DXF format, the .ecs file is used to
orient the model in the world coordinate system.

8.3.3 GMA Struct - GeoGraphix™

CVTGMS expects an ASCII version of the .MMD
model description file as input, which may be gener-
ated using MMD_ASC.EXE.  Note that
MMD_ASC.EXE expects a STRUCT .MMD file in
R2 format.

CVTGMS retains block names from the GMA model.
The density for each block is calculated by CVTGMS
as the simple average of all densities within the GMA
model block.

CVTGMS output to GMA format is not implemented
at this time.

8.3.4 GM-SYS

When importing a GM-SYS model, CVTGMS ex-
pects a surface file (.sur) and a block file (.blk) as the
minimum inputs.  An external coordinate system
(.ecs) file, if present, will be used to orient the model
in the world coordinate system for DXF output.
If a view file (.vew) exists, CVTGMS will allow you
to select the view you wish to export.  For instance,
you may wish to export only a small portion of the
model to another format.  Simply choose the view
you with to use from the View menu, manipulate the
model with any of the commands available under the
Execute menu, then save the model to the selected
output format using the Save As... command under
the File menu.  All portions of the model outside the
red dashed line (the view boundary) will be excluded
from the output file.

CVTGMS writes at least five files when creating a
GM-SYS model:  .sur, .blk, .vew, .grv, and .mag.  The
.sur and .blk files written by CVTGMS define the
model in GM-SYS format.  A view file is created
with two views, a default "full view" designed to in-
clude the entire model, and an "infinity" view. The
well file contains no wells, only an end-of-file flag.
The .grv and .mag files contain only end-of-file flags
unless data were contained in the input file (e.g. LCT
and GAMMA formats).

If the imported file is of DXF format and contains
"Elevation" and "Extrusion" information, CVTGMS
saves this information in an additional GM-SYS
model file with a .ecs extension.
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8.3.5 IHF - GeoSec®

CVTGMS reads GeoSec’s Import Horizon Format
(IHF) files, interpreting all Geological Boundary
codes except “marker (90)” and “boundary (7)” as
surfaces.  All horizons not saved in the model are
written to an ASCII file (*.sol) suitable for import-
ing and plotting as a symbol file into the resulting
model.  “Boundary” entries are used to calculate the
lateral and depth extents of the model.

The Assign Block Names function will attempt to
assign block names based on the horizon names and
model geometry.  Blocks which remain without a
name at the end fo this step will be “Unlabeled” and
assigned a default pattern to make them more visible
in GM-SYS.  Horizon names which are not used will
be written to a log file.  Additional Attributes (den-
sity, velocity, etc.) are not currently supported.

8.3.5 Card Image 7 - GeoQuest®

CVTGMS reads horizons and faults in the Card Im-
age 7 format (*.dat).  The minimum and maximum
X, Y, and Z coordinates are used to define the limits
of the model and the initial “Full View” for GM-SYS.
CVTGMS exports a model as faults

8.3.5 2MOD® - Fugro-LCT

CVTGMS reads ASCII model files generated by
Fugro-LCT, Inc.'s 2-MOD program.  Fugro-LCT
models must consist of connected polygons; "float-
ing" polygons are not allowed.

CVTGMS outputs ASCII 2-MOD model files.  User
may specify output distance units.  When converting
GM-SYS models with 2-1/2 D blocks, CVTGMS
averages the densities of bodies beyond the +y and -
y limits of the blocks to generate the single value
required by 2-MOD models.

8.3.6 GAMMA - Chevron

CVTGMS reads ASCII model files generated by
Chevron's GAMMA program.  GAMMA models
must consist of connected polygons; "floating" poly-

gons are not allowed at this time.  The Snap... func-
tion ensures that polygon boundaries match exactly.

When converting GM-SYS models with 2-1/2 D
blocks, CVTGMS averages the densities of bodies
beyond the +y and -y limits of the blocks to generate
the single value required by GAMMA models.
CVTGMS outputs ASCII GAMMA model files.

8.3.7 SAKI - US Geological Survey

CVTGMS imports ASCII model files from the US
Geological Survey's SAKI modeling program.
CVTGMS looks for a .CMD command file, where it
expects to find the SAKI parameter (parms) list.
Loading will fail if CVTGMS does not find the
"mfile" parameter in the command file.   CVTGMS
loads polygon information from mfile, and gravity
and magnetic data from gfile and hfile, respectively,
if they exist.  The Earth's field is extracted from the
efield, einc, and edec parms and the profile azimuth
from azimuth.  All prisms are assumed to lie perpen-
dicular to the profile azimuth, i.e. relative strike ==
90 degrees.

CVTGMS preserves block names, density, suscepti-
bility, and remanent magnetization (magnitude, in-
clination, declination) and lengths of 2 ½-D blocks.
CVTGMS constructs an initial view from the xxx,
zzz, ggg, and hhh parms, if available; otherwise the
"Full" view is identical to the "Infinity" view.

SAKI models generated by CVTGMS consist of a
minimum of two files, .cmd and .bod., containing
the parms and polygon information, respectively.  If
gravity and/or magnetic data are present in the input
model format, .ggg and/or .mmm files will also be
written.

CVTGMS writes parm records for all of the param-
eters described in the Input Section, above.  The xxx,
zzz, ggg, and hhh parms are generated from the se-
lected view (default is "Full" view), if applicable.
Note that SAKI does not support skewed models;
relative model strike is assumed to be 90 degrees.
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Supporting software NGRF and XYZGMS make
working with GM-SYS easier and more efficient.

9.1 NGRF
NGRF provides an easy way to find the Inclination,
Declination, and Total Field strength anywhere on
earth, at any elevation, at any time between 1900 and
the present.  Version 1.5 included the new DGRF
1990, the new IGRF 1995, and IGRF's for 1900 to
1940.

To use NGRF, simply type "NGRF" and change any
of the four input parameters displayed on the left side
of the screen (Date, Latitude, Longitude, or Eleva-
tion).  NGRF will recalculate the Magnetic Refer-
ence Field Values for those parameters when you type
"Enter" or move to another parameter with the arrow
keys.  The calculation uses the latest theoretical model
of the earth's magnetic field published by the Inter-
national Association of Geomagnetism and Aer-
onomy, Division V, Working Group 8 (C.E. Barton,
Revision of International Geomagnetic Reference
Field Released, EOS Transactions 77, #16, April 16,
1996).

NGRF allows the elevation (positive values are above
sea level) to be input in meters, kilometers, feet,
kilofeet, or miles.  From the elevation field, press
<enter> or the right-arrow key until the units field is
highlighted.  Press the space bar to cycle through the
unit choices.

Context-sensitive help is available by pressing the
'F1' key.  Press  <Esc> to exit help.

You can use a mouse to pick the parameters you want
to change with the left mouse button.  Two clicks
with the right mouse button anywhere on the screen
will cause the program to end and return you to DOS.

Press <Esc> twice or <Ctrl><Enter> to exit NGRF.

9.2 XYZGMS
XYZGMS is a command-line driven GM-SYS util-
ity program that will read GEOSOFT format 'XYZ'
files with several fields of data, and create a GM-SYS
model.  Input data fields may include topography,
additional global horizons, gravity data, magnetic
data and station elevations.

XYZGMS incorporates the following features:

•   XYZGMS reads free format ASCII files, (i.e.
fields of data separated by spaces).  Data fields
can be in any order you chose.  Geosoft line head-
ers need to be present.  You select which 'Line'
will be used for building the model

•   XYZGMS can window and decimate your data
to a subset of your data file.

•   XYZGMS allows you to select default values
for missing data types (e.g. magnetic station el-
evations).

•   XYZGMS creates all necessary files for a
GM-SYS model including conveniently recalled
views.

•   XYZGMS allows you to specify a starting X-
coordinate offset.

•   XYZGMS calculates a coordinate transforma-
tion that enables location of the model profile in
“real-world” coordinates.

9. SUPPORTING UTILITIES
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Note that XYZGMS converts a multi-segment line
into a single-segment profile as shown on the fol-
lowing page.  The black line represents the original
profile as digitized by the user.  The red line is the
location of the model profile in real-world X,Y space
with values projected perpendicularly onto the model
profile. The model-profile azimuth is based on the
first and last points in the original profile.  The pro-
file location is then shifted to minimize the average
mis-fit.

XYZGMS generates a coordinate transformation
from the original (X,Y) coordinates & profile azi-
muth to the profile coordinates (X’,Z).  The coordi-
nate transformation is stored in the.ECS file.

RUNNING XYZGMS:

XYZGMS is a command line driven program.  Typ-
ing XYZGMS followed by a number of parameters
and options runs it.

Usage:

XYZGMS in out -l= -zg= -zm= -zeg= -zem= -eg=
-em= -zt= -t= -u= -d= -x= -x0= -y= -s=

where:

in (required) name of the XYZ file (.XYZ as-
sumed)

out (required) root name of the output files (six
files)

-l= (required) line type [B, T, or L] and line
number

-zg= column for gravity values (a gravity or mag-
netics column is required)

-zm= column for magnetics values (a gravity or
magnetics column is required)

-zeg= column for gravity elevation values (+ is up)
-zem= column for magnetics elevation values (+

is up)
-eg= value for constant gravity elevation (+ is up)
-em= value for constant magnetics elevation (+ is

up)
-zt= column for topography values (+ is up)
-t= value for constant topography (+ is up)
-u= unit conversion (default meters).  If input is

in:
feet -u=3.28
kilofeet -u=0.00328 or -u=3.28E-3
kilometers - u=0.001 or  -u=1E-3
miles -u=6.2121E-4

-d= decimation factor.  Take only every d th
point (Default -d=1)

-x= min,max X limits. The default is to pass
entire X range.
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-x0= x-coordinate of first point in profile.  The

default is 0.
-y= min,max Y limits. The default is to pass

entire Y range.
-s= min,max Station limits.  The default passes

all stations.
-h= h1,h2,h3... columns for up to 15 layer hori-

zons. ( + is down )
-q 'quiet mode' (i.e., suppress version message

and other non-error messages)

The first point in the model will be placed at X=0
(GM-SYS model coordinates) and GM-SYS model
coordinates will be calculated as the distance from
that point.  The -x0 parameter may be used to shift
the starting X-coordinate to any value.  Those coor-
dinates may also be shifted using the GM-SYS util-
ity program CVTGMS.

XYZGMS calculates the profile azimuth and assigns
relative strike angle=90, magnetic inclination=60,
declination=20 and field intensity=56,000 as default
values. You may change these for each model in GM-
SYS (Profile menu, set field and set azimuth) to the
proper values for your profile.

Example:    XYZGMS test test -l=L19 -d=5 -t=400
-eg=400 -zg=5

This example will read data from file test.xyz and
create a GM-SYS model named test.  Only every 5th
point will be read, topography elevation is constant
at 400 meters, gravity data is in the 5th field of the
input data file, and the elevation of the gravity sta-
tions is constant at 400 meters.

Two sample files are included with the distribution:

1. gms.xyz  is a sample input data file
2. sample.bat is a sample batch file using gms.xyz

SPECIFICATIONS:

Max. number of columns (characters) in input record:      256

Max. number of data fields in input file:                          50

Max. number of data points in output model:                   16,000.
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10.  GM-SYS MODELING AND

OASIS MONTAJ

All GM-SYS distributions include a suite of GXs for
building, modifying , opening, and plotting GM-SYS
models from within Oasis montaj.  Load the Oasis
menu file gmsys.omn to access these functions.  If
Oasis montaj is detected on the target system during
installation of GM-SYS, you will have the option of
installing these files.

When models are opened using these GXs, a link is
established to communicate cursor position and other
information between GM-SYS and Oasis montaj.
Two buttons on the GM-SYS toolbar control whether

cursor tracking is always active, occurs only on a
mouse click, or is disabled.

Notes:
1)  Each time a model is opened from within OASIS
montaj, a new instance of GM-SYS is started.  The
New Model and Open Model functions in these in-
stances of GM-SYS are disabled.

2)  Cursor tracking and all included GM-SYS GXs
are designed to work with the OASIS montaj Free
Interface version.
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10.1 BUILDING GM-SYS MODELS
WITHIN OASIS MONTAJ
Under the New Model submenu of the GM-SYS
Menu, there are four methods for building new mod-
els from within Oasis montaj; two build models from
databases, one method builds models from grids
along a digitized profile, and a fourth option copies
or “clones” an exisiting model.

1) From current mark... builds a model from the cur-
rent line in the current database.  This option expects
some portion of the current line in the database to be
“marked” or highlighted.  The “mark” designates a
range of fiducials or locations which will be used to
build the GM-SYS profile and does not determine
which channel(s) are used.  (Hint:  You can select all
of the data in a line by double-clicking on any chan-
nel header).

2) From map profile... can extract model horizons,
data, and topography from specified grids along a
digitized profile.  Grids may have differing projec-
tions and distance units.

3) From selected database lines... builds one or more
models from the selected lines in a database.  It does
not utilize “marked” data.

These first three options provide dialogs from which
you may elect to include observed data, station el-
evations, and topography.  Additional dialogs allow
you to include known horizons,  and measured or
calculated gradient data in your models.  Your new
model will inherit the projection information from
the database or the first grid sampled, depending upon
the method you use.

Note:  These techniques generate an intermediate
XYZ file (<modelname>_gms.xyz), and a
BATCH file (<modelname>_xyzgms_cmd.bat).
XYZGMS is then used to generate the new
GM-SYS model files (See Section 9).

XYZGMS will convert multi-segment profiles
into a single-segment profile as shown on the fac-
ing page.  The black line represents the original
profile as specified by the user.  The red line is
the location of the model profile in real-world
X,Y space with values projected perpendicularly
onto the model profile. The model-profile azimuth
is based on the first and last points in the original
profile.  The profile location is then shifted to
minimize the average mis-fit.

4) Clone an exisiting model... copies the model struc-
ture of an existing model to a new location, specified
by digitizing an origin and a second point to deter-
mine azimuth.  New gravity and magnetic data may
be extracted from specified grids at the new loca-
tion.  This method can not substitute new topogra-
phy, due to the possible complexity of intersecting
surfaces, but you may import and merge a new topo-
graphic surface once you’ve opened the model in
GM-SYS.

The fifth option, New blank model..., starts GM-SYS
with no model loaded.  Cursor tracking (see Section
10.3) is not enabled in this case.
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10.2 WORKING WITH EXISTING
MODELS WITHIN OASIS MONTAJ
Use the Existing model submenu to open, modify,
copy, or plot the location of an existing model in your
workspace.  You may open an existing model for ed-
iting within GM-SYS by selecting the Open a
model... option.  Selecting Add data to model... al-
lows you to add or replace observed data in an exist-
ing model.  Clone an existing model..., described in
the previous section, duplicates an existing model
and extracts new data.  Plot model location... can
plot the profile trace, gravity station locations, or mag-
netic station locations of an existing model on a
Geosoft map, based on a selected View within the
model.  Plot model Plan View... allows you to select
any saved View in a model and the plot the Plan View
to a Geosoft map,

10.3 CURSOR TRACKING
When a GM-SYS model is created from a database,
from grids, or from an XYZ file, a coordinate trans-
formation is written into the .ECS file that translates
between GM-SYS “profile” (X,Z) coordinates and
“real world” (X,Y,Z) coordinates.  A dynamic inter-
face allows GM-SYS to send the (X,Y,Z) coordinates
of the cursor to OASIS montaj and have them dis-

played as a linked cursor within the databases and
maps.  The cursor will track correctly in 3-D maps
when the 3D Viewer is active.  If projection infor-
mation is associated with the X and Y channels in
the source database or with the grids from which the
model was created, the projection information will
be stored in the .ECS file and will be used to cor-
rectly project the coordinates reported by GM-SYS
to OASIS montaj.

Two buttons in the GM-SYS toolbar control how the
cursor position is relayed to OASIS montaj.  Press-
ing the left button (default) allows constant report-
ing of the cursor position to OASIS montaj.  Press-
ing the right button causes GM-SYS to report the
cursor position only on a mouse click.  You may elect
to deselect both buttons, which prevents GM-SYS
from sending cursor coordinates to OASIS montaj.

10.3 LOADING GM-SYS PLOTS
INTO GEOSOFT MAPS
To generate a Geosoft-compatible plot from
GM-SYS, just select the “Geosoft Driver” as the
printer selection in the GM-SYS printer setup.  This
will generate a Geosoft “.PLT” file that can be loaded
into a Geosoft Map.  Patterns do not translate but are
displayed as the solid foreground color.
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11. TUTORIAL - CREATE

NEW MODEL

This tutorial is designed to lead the new user through
the features of GM-SYS.  In it, we assume that the
user has a basic understanding of the features of
Windows.  Most users will pick up the basics very
quickly, allowing them to manipulate models and
obtain a reasonable fit of the model response to the
data.

The largest section of the tutorial leads the user
through the "Create New Model" procedure.  Some
steps in that procedure may not be intuitively obvi-
ous to the first-time user, but after having worked it
through once, it is relatively straight forward.

11.1 OVERVIEW
Before we begin the step-by-step tutorial, let's stop
and take a look at the steps we will use to create a
model.  We will:

1) create a single block, extending from minus "in-
finity" (x=-30,000 km) to plus "infinity"
(x=+30,000 km), and to a specified depth (de-
fault value: z=+50 km);

2) use a sample data file to import topography and
observed gravity and magnetic data;

3) insert key geologic horizons extending from mi-

Figure 11.1:  Complete model SIMPLE2.
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nus infinity to plus infinity; and

4) create a detailed geologic model in the area of
interest that fits the observed data.

Steps 1 and 2 are performed using the New Model
Creation dialog.  Steps 3 and 4 are carried out using
the mouse modes available in the Action Tool Box
or Action Menu.  We will change views of the model
to work first at the mega-scale, and finally at a de-
tailed scale, looking at smaller portions of the model.

Our exercise will be to input a simple model with a
basement high and overlying sediments, shown in
Figure 11.1.

11.2 CREATE NEW MODEL
The "Create New Model" procedure will create the
single block referred to in Step 1.  In this tutorial, we

will also import topography, observed gravity data,
and observed magnetic data and station elevations,
although this is not required.

To begin, start GM-SYS and click "OK" on the reg-
istration screen; an empty Main Window will appear.
Select New Model… from the File Menu (or click
on the New Model icon at the left end of the Menu
Tool Bar) to activate the New Model Creation dia-
log, shown on the following page.

The New Model Creation dialog is partitioned into
four sections.  We will work with them in order of
occurrence.

Cross-Section:  Set the horizontal and depth extents
for the model.  For this exercise, the observed data
extend from 0 to 45 km along the profile and the

Figure 11.2:  New Model Creation dialog.
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model will extend from 0 to 50 km in depth.  Enter
these values in the "Cross-Section" area of the dia-
log, as shown in Figure 11.2.

Azimuth/Strike Angles:  An azimuth of 180° means
that the profile goes from north to south, with the
plus X direction being due south (180° clockwise
from True North).  The profile azimuth is not used in
the gravity calculations, but must be entered correctly
if you intend to do magnetic modeling.

In our example, the profile runs from south to north;
i.e. the profile has an azimuth of 0º.  Select the
"Change" button and enter 0 in the Profile Azimuth
field.  We will accept the default relative strike of
90º.  That means that the strike direction will be 90°
from the direction of the profile.   In our example,
the strike is east-west.

Topography, Gravity Stations, and Magnetics Sta-
tions:  We will now import topography, gravity sta-
tions and magnetic stations from our sample data file.
Select the "Import From File" option in the Topogra-
phy sub-section.  The dialog shown in Figure 11.3
will appear:

1) Select the "File…" button to activate a file-se-
lection dialog and choose the file SIMPLE2.ASC
included with this tutorial.  You will then be
given an opportunity to view the contents of the
selected file, as shown in Figure 11.4 on the fol-
lowing page.

2) Observe that there are seven lines of header in-
formation prior to the beginning of the data in
this example, that all distances are supplied in
kilometers, and that Z-values are supplied as el-
evations (positive upward), not as depths (posi-
tive downward).  Also, the magnitude and di-
rection of the Earth's field at the time and loca-
tion of the survey is supplied in the header; listed
as "Earth's field".  You will need to supply this
information for your own magnetic modeling.
Now click "OK" and return to the Import From
File dialog.

Figure 11.3: Default values for the
 Import from File dialog.

Figure 11.4: File viewer displaying
SIMPLE2.ASC.
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3) Now, select "+up" (elevations are positive) and

enter "7" in the "Skip Lines" field.  We will ac-
cept the default units and default fields for X
and Z (topo).  Click "OK" to return to the New
Model Creation dialog.  Now go through the
same process for the Gravity Stations and Mag-
netics Stations.  Note that the second field (topo)
is also the appropriate field for gravity station
elevations (Z), but the "Z" field for Magnetics
Stations will be "5" and the observed data (Obs)
are in column 4.

Earth's Magnetic Field:  You may now enter the val-
ues for the Earth's field strength and direction sup-
plied in the header (see Figure 11.4) by selecting the
"Change" button and filling in the appropriate fields.
Click "OK" to return to the New Model Creation dia-
log.  If all of the settings are satisfactory, click "Cre-
ate".

You should now have a new model on the screen
like that shown in Figure 11.5, below.

Click the right mouse button in each of the anomaly
panes to activate a pop-up menu and select "Auto
Scale".  This function automatically adjusts the ver-

tical scale and limits on each pane to include all of
the data.

By default, GM-SYS calculates and displays an "er-
ror curve" (calculated - observed) for the Gravity and
Magnetic panes.  To hide these for now, you may
select the "Display" option from the same pop-up
menus and toggle the display of the Gravity Error

and Magnetic Error curves off.  They may be toggled
on at any time by re-accessing these menus.  If grid-
lines are present on your initial image, they may be
turned off in a similar fashion.

Now is a good time to save your newly-created
model.

Figure 11.5: Initial view of newly-created model.
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11.3 TYING TO INFINITY
The next step in entering the model from Figure 11.1
is to enter the surfaces that extend from one side of
the model to the other.   In our example, there are
two such surfaces:  the top of the "Basement" block,
and the horizon between "Upper Sediments" and
"Lower Sediments".   Both of these horizons should
be extended to "Infinity" to remove edge-effects in
our calculations.

Select the View Menu
and choose Infinity.
Now change the upper
and lower limits of the
cross-section view so that
you are only looking at
the top 6 km of the model.
This may be done in one
of two ways:

1)  Click the right mouse button in the vertical axis
area of the cross-section pane (near the "Depth" la-
bel) to activate the pop-up menu and select "Change
Range".  Enter "-1.5 km" for the minimum depth (Z
is positive downward in GM-SYS) and "6.0 km" for
the maximum depth, then click "OK".

or,

2)  Use the scroll bar on the right side of the cross-
section pane to modify the range.  Dragging the ends
of the white box changes the range within the pane,
and dragging the middle of the box shifts the view
upward or downward without rescaling.
You should now see a view of the model similar to
that shown below:

Now we need to enter the two new surfaces using
the Split Block command.  Note:  When "splitting a
block," the intended starting and ending points must
be visible on the screen before beginning Split Block.
Thus we must first use the Add Point mode to insert
the starting and ending points for our new surface.
The points we wish to add are circled in the figure
above.

Select the Add Point mode by clicking on the "+"
icon on the Action ToolBar or by selecting it from
the Action Menu.  Move the cursor to the surface
where you want to add a point (approximately X=-
30,000 km, Z=3.5 km) and click the mouse button to
insert the point.  Insert another point in a similar
manner on the other side of the model (X=+30,000

Figure 11.6: Adding regional surfaces in the “infinity” view.
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km, Z=3.5 km).
We can now move these new points to the exact co-
ordinates desired by using the Examine function.
Select Examine from the menu or the "eye" on the
toolbar and click on one of the points that you have
just added.  Its coordinates will appear in the dialog
box.  Enter the values shown below:

Point 1: X=-30000 Z=3.5
Point 2: X= 30000 Z=3.5

You are now ready to
start the Split Block
operation.

Select Split Block from the menu or toolbar.  Click
on "Point 2" which you have just added on the right
side of the screen (refer to Figure 5 on the previous
page).  A "rubber band" will now be attached to your
cursor (see figure above).  Move the cursor to the
"Point 1" that you added on the other side of the
screen.  Make sure the cursor is exactly over the point
and click the mouse button.
When the dialog shown at
right appears, choose "Accept/
Edit new block".
You should now have a new
block highlighted with its
block data displayed in the
dialog box, as shown on the
following page.

You can change the block
name and density by clicking
on the appropriate item in the
dialog box and typing in the
desired value.

In the dialog box, change the
block name to "Lower Sedi-
ments" and the density to 2.35
g/cm3.  Click "OK".

HELPFUL HINT:  Following the instructions above,
you started on the right side of the model and ended
with a point on the left.  The highlighted block was
above (to the right of) the new surface as you drew
it.  While using Split Block, the new block is always
created on the right-hand side of the new surface,
when traveling along the new surface in the direc-
tion in which it was created.  If you had started on
the left side of the model and ended on the right, the
new block would have been below the new surface,
instead of above.  This should not be a problem, but
you may need to Examine the blocks and enter the
proper information in the dialog box.
Now, in a similar fashion, insert a new surface for
the horizon between the upper and lower sediments.
The two ends of that surface should be:

Point 3: X=-30000 km; Z= 2.0 km
Point 4: X= 30000 km; Z= 1.5 km

Figure 11.7: Examine Block dialog, allowing the user to set the
parameters for the newly-created block.
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In the dialog box, change the block name from "Copy
of Lower Sediments" to "Upper Sediments" and the
density to 2.50 g/cm3.

Now we have the gross features of our model built.
The surfaces that need to be tied to infinity are taken
care of and we can return to the geologic model of
interest.  We will do this through the View Menu.

This is a good time to save your model.

In the View Menu, select Startup.  Again set the up-
per and lower limits of the model window to -1.5
and 6.0 respectively.  Your model should look like
the figure on the following page.

Now save this view so you can easily return to it.
Select the View Menu and select Edit Views to acti-
vate the View List dialog.  Select the Startup view,
click "Repl. w/CView" (replace with current view),
then click "OK" to close the dialog.

11.4 SKETCHING YOUR MODEL
Looking back at Figure 11.1, we see that we still need
to build the basement high and truncate the "Lower
Sediments" on either side of that high.

First, use the Add Point command to place anchor
points on both surfaces near the edge of the area of
interest (see Figure 11.9).  Placing anchor points pre-
vents changes on-screen from propagating into ar-
eas off the screen.  Notice that as long as you hold
the mouse button down, the newly added point will
move with the cursor.

Secondly, add and move points upward on the intra-
sediment horizon (between upper and lower sedi-
ments) to make room for the basement high.  In the
same fashion, add and move points on the basement
surface until it is where you want it.  Your model
should be similar to the one shown in Figure 11.9,
below.

Now, create two new surfaces to truncate the "Lower
Sediments" against the "Basement", as shown in Fig-
ure 11.10 on the following page.  This will leave a
remnant block with lower sediments above the base-
ment high.

Figure 11.8:  Working view of the new model.
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Delete the remnant block of lower sediments.  Select
Delete Surface from the Action Menu or Action
ToolBar.  Move the cursor to the surface you want to
delete and click on a point on that surface.  The fig-
ure below shows one of the two points that would
work in this example.

A new block has now been formed joining the two
blocks on either side of the deleted surface.  The

blocks on either side were the "Upper Sediments"
and "Copy of Lower Sediments" (they may have
slightly different names depending upon which di-
rection you drew the surface using the Split Block
function).  You must select the block you wish to
keep from a pop-up menu, thereby extending the
properties of that block into the area where the other
block existed.  Indicate that you wish to keep the
"Upper Sediments" block.

Figure 11.9:  "Anchor points" may be used to limit the area affected
by changes to a surface.

Figure 11.10:  Truncating the lower sediments against the base-
ment high, leaving a remnant block to be removed.
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You should now use the Examine function to make
sure the densities, susceptibilities, and names of all
the blocks have been set to the desired values, shown
in the table below.  For instance, change the name of
the lowermost block from "Crustal rock" to "Base-
ment" by selecting Examine from the Action Menu
(or the "eye" in the Action Toolbar) and clicking the
mouse within the polygon to bring up the Examine
Block dialog.  While the dialog is open, you may
also change the block parameters to those shown in
the table.  Click "OK" when you are finished with
each block and then select another block.  Note that
it is possible to have more than one block with the
same name.

You should now have a completed model which ap-
proximates the one shown in Figure 11.12.

You are now ready to calculate the gravity and mag-
netic response to your geologic model and to start
refining the model.

11.4.1 Applying a DC Shift

Select the Calculate function from the Menu ToolBar
(calculator icon) or select Calculate from the Com-
pute Menu.

When you first perform the Calculate function, the
calculated gravity and magnetic response may be off

Figure 11.11: Select a point on the surface to be deleted.

Table 11.1 Tutorial  Table
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the screen, as the calculated absolute gravity values
are of the magnitude of 5,000 mGal.  A "DC shift"
must be applied to the data in order to match the cal-
culated curve with field data.

By default, GM-SYS calculates an RMS difference
between the observed data and calculated response
and applies that difference to the calculated response
(Auto mode).  To enter your own DC shift value,
select Gravity DC Shift or Magnetic DC Shift from
the Profile Menu, or click the right mouse button in
the appropriate anomaly pane and select DC Shift
from the pop-up menu.  You then have the option of
selecting Auto, entering an Absolute shift, or choos-

ing a Station on the profile to serve as an "anchor
point", at which point GM-SYS will always force
the curves to match.  If you choose the Station op-
tion, that point is highlighted in the anomaly pane by
a double arrow, as indicated in the display shown
below.

If you use the Station option for applying a DC Shift,
you should pick a station outside the area of interest,
probably at one end of the profile.  If you make a
change in the model which affects the gravity at this
point, it will alter the entire curve in order to main-
tain the "fit" at this station.  It is often advantageous
to select a point which is normally off the screen and

Figure 11.12:  Completed "roughed-out" model.  Display of block labels
and block parameters are turned off.

Figure 11.13:  Arrows indicate the location of the Station
used to calculate the DC Shift using the Station option.
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beyond any portion of the model which is likely to
be altered.  When modeling regional features extend-
ing across the entire model, the effects of this "an-
chor point", and its location, should be kept in mind.
For this example, select the Auto option.  After ap-
plying a DC Shift, you will want to apply Auto Scale
to each of the anomaly panes to be sure that all of the
observed and calculated curves are visible.  In the
above display, the limits have been changed to -120
and 120 gammas.

You may now save the anomaly pane limits by se-
lecting Edit Views from the View Menu and replac-
ing the Startup with the current view.

This is a good time to save your model.

11.4.2 Label Placement

Labels are turned "on" by default, but they may ini-
tially appear outside of the working view.  Using the
Move Label option, the labels for each block be

placed in their desired locations.  Select the Move
Label option from the Action Menu or Action
ToolBar, and click the "Snap Mode" radio button.
Click the mouse in the desired block and its label
will automatically be moved to that location.  If you
wish to change the block name, use the Examine func-
tion.

If there is not enough room within the block to dis-
play the label, the label may be moved outside of the
block and a pointer extended to the block.  Select the
"Drag Mode" radio button and place the mouse cur-
sor at the lower left-hand corner of the block name
(above the block parameters, if they are displayed).
Depress the mouse button and drag the label to its
new location; the pointer will extend from the old
location to the new one.  You may also drag the other
end of the pointer by selecting and dragging it.  When
you are happy with the placement of the labels, save
your model.

Figure 11.14:  Finished model, with labels positioned on-screen.
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If you don't want the air block label to appear on the
screen, you may zoom out and "Snap" it to a location
well beyond the area of interest before zooming in.

Your finished model should appear something like
that shown in Figure 11.14.

Don't forget to save your model.

This concludes the Create New Model Tutorial.  We
have worked through the procedure for generating a
starting model and importing data, and have devel-
oped a simple model.  A more complex model can be
developed using the same simple steps introduced
here.

You may continue to explore features of GM-SYS
by manipulating the model using the Add Point, De-
lete Point, Move Point, Move Group, Split Block,
Delete Surface, and Examine functions.
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